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To do the exercises and assignment in this book, you need to have ArcGIS 

Desktop 9.3 software and the ArcGIS Network Analyst 9.3 extension installed 

on your computer. 

The first chapter's exercise was built using version 9.2 of the software.
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Exercises in previous ArcUser issues demonstrated how the 

ArcGIS Network Analyst 9.2 extension can be used to model 

essential services provided by existing and proposed fire stations 

in King County, Washington. In this issue, the area modeled is 

farther north—the city of Burnaby, British Columbia, Canada. 

This exercise will model optimized response areas for a fire 

department that have been optimized to include time-based 

travel penalties for steep slopes and sharp turns. 

The Slope/Turns Exercise

The challenge in this exercise is to build the street dataset to 

display slope in percent for the Burnaby Fire Department's 

service area. The department is building a new fire hall. Fire  

Hall 7 will serve a large area in central and western Burnaby. 

Burnaby's irregular terrain includes slopes of more than  

15 percent. To properly model time-based travel, a slope 

correction factor for steep streets was developed and field-

tested. The slope adjustment, together with global turn rules, 

was applied to posted speed limits to calculate valid travel times 

and define optimal response areas.

Slopes, Sharp Turns, and Speed
Refining emergency response networks to accommodate steep slopes and turn rules

By Mike Price, Entrada/San Juan, Inc.

Introducing Burnaby

Originally a rural agricultural area, Burnaby, British Columbia, received 

city status in 1992 and has developed into a major business, residential, 

and transportation corridor between Vancouver and British Columbia's 

Lower Mainland. With a population of 202,799 (in 2006) and an areal 

extent of nearly 100 kilometers, Burnaby is the third largest urban center 

in the province. It is bordered by the Burrard Inlet on the north and 

the Fraser River to the south. Burnaby's landscape is characterized by 

hills, ridges, valleys, and an alluvial plain. Elevation ranges from mean 

sea level to 375 meters. Land features have controlled and constrained 

development throughout this community.

The Burnaby Fire Department serves the entire municipal area and 

provides aid response into neighboring jurisdictions. The department 

staffs six fire halls, and a new station will open soon. The first line of 

response includes six first line engines, four ladders, a command unit, 

rescue truck, an equipment truck, and other specialized equipment. 

The agency's fire suppression and administrative staff numbers 286. 

In 2006, the department responded to 13,400 calls. The Burnaby 

Fire Department works closely with the city's excellent Engineering 

Department to plan and optimize service throughout the area. Burnaby 

Engineering uses ArcGIS Network Analyst to optimize response areas.
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Getting Started

Download the zipped sample dataset for this exercise from 

ArcUser Online (esri.com/arcuser) and place it near the root of 

the drive that houses the project. Unzip the data and explore it 

in ArcGIS ArcCatalog. Note that the sample data is contained in 

a file geodatabase. The geodatabase includes a special feature 

dataset named Transportation_Model that contains a single 

feature class named Highways_Streets. This feature class will 

support time-based modeling. Study the geodatabase layer files 

for symbolizing municipal boundaries, fire stations, hydrants, and 

historic incidents and the registered JPEG and its layer file.

This exercise will model detailed slope derived from a large 

triangulated irregular network (TIN) model. Because the actual 

background TIN is too large to easily download, a picture of 

hillshaded slope (Slpp_300.jpg) will be used instead to emphasize 

steep areas.

Start ArcMap, open a new, blank map document, and save it as 

Burnaby1.mxd. Load the City Boundary.lyr from \Burnaby 

\GDBFiles\UTM83Z10\. Check the layer's coordinate system and 

load Analysis Area.lyr, Streets – Slope.lyr, and Fire Halls.lyr from 

this same folder. Note that Streets - Slope has been thematically 

symbolized. From \Burnaby\ JPGFiles\UTM83Z10\, load Slope, 

Percent, Hillshade JPEG.lyr and move it to the bottom of the 

table of contents (TOC). Ignore the warning box about the spatial 

reference.

After downloading and unzipping the sample dataset, load City Boundary 
.lyr, Analysis Area.lyr, Streets – Slope.lyr, and Fire Halls.lyr, and the JPEG 
image of a hillshade.

What You Will Need

•	ArcGIS Desktop 9.2 (ArcInfo, ArcEditor, or ArcView 

license level)

•	ArcGIS Network Analyst 9.2 extension

•	Sample data from ArcUser Online

http://www.esri.com/news/arcuser/0708/files/burnaby_1.zip
http://www.esri.com/news/arcuser/0708/files/burnaby_1.zip
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Preparing the Street Data

Open and inspect the attribute table for Streets - Slope. Eight 

fields in this table contain zero (0) values. Before the slope can be 

depicted, values for the LENGTH_KM, MINUTES_R, SLOPE_ABS, 

SLOPE_ADJ_1, MINUTES_S, and SPEED_ADJ1 fields will be 

calculated.

The values for these fields will be calculated outside an editing 

session. If a field requires recalculating, simply zero out the field. 

Right-click on the field header, choose the Field Calculator, select 

the field name to zero out, input “0” into the text field, and click 

OK.

1. Locate LENGTH_KM field and right-click on its header. Select 

Calculate Geometry to calculate length of all street segments 

in kilometers. In the Calculate Geometry dialog box, set the 

Property as Length, the Coordinate System to Use Coordinate 

System of the Data Frame, and Units as Kilometers and click 

OK.

2. To calculate the unadjusted travel time, right-click on 

MINUTES_R and choose the Field Calculator. In the Field 

Calculator text field, input the following equation and click 

OK.

 [Length_Km] *(60/ [SpeedZone])

3. Next use the Field Calculator to determine the absolute slope 

and place that value in the SLOPE_ABS field. Remove the 

previous formula from the text field. Choose the Abs function 

from the list of functions and select the SLOPE1 field. Abs 

([Slope1]) should display in the text field. Click OK.

4. Move the table if necessary to look at the changes these 

calculations have made to the thematic display of the Streets - 

Use Calculate Geometry 
to calculate all the street 
segments in kilometers.

Use the Field Calculator 
to generate unadjusted 
travel time values for 
the MINUTES_R field.
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Slope layer. Keep the Streets - Slope table open and save the 

map document. 

Calculating Slope Adjustment

1. In the Streets - Slope table, calculate slope adjustment factor 

by right-clicking on the Slope_Adj1 field header, choosing 

Field Calculator, and removing the previous formula from the 

text field. Input the following equation and click OK.

 1 + ([Slope1]/10)^2

 Slope_Adj1 is a multiplication factor that increases travel time 

for steep slopes. Table 1 shows the empirical slope factors in 

1 percent intervals. Notice that it takes twice as long to climb 

or descend a 10 percent slope than it does to travel on flat 

street segments.

2. Now, calculate the slope-adjusted travel time in minutes. 

Right-click on the MINUTES_S field header, choose Field 

Calculator, remove the previous formula from the text field, 

and input the following formula:

 [Minutes_R] * [Slope_Adj1]

Use the absolute value function on 
SLOPE1 to obtain absolute slope values.

Note the effects the field calculations have made on the 
symbolization of the Streets – Slope layer.
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Table 1: Slope adjustment factors.

Slope (in percent) Travel Time Multiplier Comments
0 1.00 Base time

1 1.01

2 1.04

3 1.09

4 1.16

5 1.25 1.25 times as long

6 1.36

7 1.49

8 1.64

9 1.81

10 2.00 Twice as long

11 2.21

12 2.44

13 2.69

14 2.96

15 3.25

16 3.56

17 3.89

18 4.24

19 4.61

20 5.00 5 times as long

21 5.41

22 5.84

23 6.29

24 6.76

25 7.25

26 7.76

27 8.29

28 8.84

29 9.41

30 10.00 10 times as long

35 13.25

40 17.00 Very steep

3. Calculate slope adjusted travel speed in minutes. This 

calculation incorporates the slope adjustments in Table 1 

and generates the equivalent speed for travel on each street 

segment. Right-click on the [Speed_Adj1] field header, choose 

Field Calculator, remove the previous formula from the text 

field, and input the following equation:

 ([Length_Km]/[Minutes_S])*60

4. Save the map document.

Building the Street Network Dataset

Close ArcMap and open ArcCatalog. In the Burnaby_Fire 

geodatabase, navigate to the Transport_Model feature dataset 

and refresh ArcCatalog. Select the Highways_Streets feature 

geodatabase class, click on the Preview tab, and choose Table 

from the drop-down. Look at the ONE_WAY, F_ELEV, and T_ELEV 

fields.

1. In ArcCatalog, choose Tools > Extensions and check the box 

next to Network Analyst.

2. Right-click on Transport_Model, choose New > Network 

Dataset, name the new dataset Transport_Model_ND, and 

click Next.

3. Check the box next to the Highways_Streets feature class and 

click Next.
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4. Click the Connectivity button and note that End Point 

connectivity is checked. Click Next.

5. Click to modify connectivity with the elevation fields F_ELEV 

and T_ELEV. Click Next.

6. Accept Global Turns and click Next.

Defining Network Attributes and Turn Rules

Network attributes for time and distance travel must now be 

specified.

1. Click the Add button. In the wizard pane to specify the 

attributes for the network dataset, add the Length_KM, 

Minutes_R, and Minutes_S fields and set the values as shown 

in Table 2.

Table 2: Values for new network dataset.

Name Usage Type Units Data Type Set as Default

Length_KM Cost Kilometers Double No

Minutes_R Cost Minutes Double No

Minutes_S Cost Minutes Double No

2. If Oneway is not already set as a default, right-click on it and 

set it as a default.

3. In the same wizard pane, highlight Minutes_S and click the 

Evaluators button.

4. Click the Default Values tab. Right-click the element named 

Turn, choose Type, and click VBScript.

5. With the Turn element still highlighted, look for the Evaluator 

Properties button on the right side of the wizard pane. Click 

on it.

6. In the Script Evaluators dialog box, make sure Turn is set as 

type, and click the Load button. Navigate to the \Burnaby 

\Utility folder. Locate and load TurnTime.sev. Click OK.

7. Back in the previous dialog box, select Minutes_R from the 

Attribute drop-down box. Right-click the element named Turn, 

choose Type, then click VBScript.

8. With the Turn element still highlighted, look for the Evaluator 

Properties button on the right side of the wizard pane. Click 

on it.

9. In the Script Evaluators dialog box, make sure Turn is set as 

type and click the Load button. Navigate to the \Burnaby 

\Utility folder. Locate and load TurnTime.sev. Click OK. Click 

Apply. Click OK.

10. Back in the New Network Dataset wizard pane, click Next.

These 10 steps have established the turn rules for the streets 

corrected for slope and streets not corrected for slope. The 

default turn rules in TurnTime.sev specify a 10-second delay for 

left turns, a 5-second delay for right turns, and a 2-second delay 
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In ArcCatalog, set the network attributes 
for time and distance travel using the New 
Network Dataset wizard.

Under the default values for the Turn 
element for the MINUTES_S Evaluator, 
attach a VBScript.

Apply TurnTime.sev to the 
Evaluator for MINUTES_S.
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After joining the fire hall attributes 
to the network analysis layers, save 
these layers as feature classes so 
they are permanent and can be 
shared. Store these feature classes 
in the Transportation Model in the 
Burnaby geodatabase.

Use an 
expression 
to label 
the service 
areas with 
the area 
of each 
in square 
kilometers.

In the 
Optimized 
Travel 
Network, 
Slope 
attribute 
table, 
summarize 
on the 
LABEL field 
using the 
Shape_
Length 
statistics.
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for straight travel from one segment to the next. A 30-second 

penalty is imposed on U-turns. Table 3 lists the turn rules applied 

for municipal areas.

Table 3: Turn rule options.

Turn Rule Right-Turn 
Penalty (in 
seconds)

Left-Turn 
Penalty (in 
seconds)

U-Turn 
Penalty (in 
seconds)

Straight 
Line Travel 
Penalty(in 
seconds)

No Penalty 0 0 0 0

Slight Penalty 1 2 10 0

Moderate 
Penalty

2 4 20 0.5

High Penalty 3 5 30 1

Very High 
Penalty

5 10 30 2

Turn Angle, 
Minimum

30 210 150 330

Turn Angle, 
Maximum

150 330 210 30

Turn Angle, 
Range

120 120 60 60

11. In the next wizard pane, click Yes to establish driving 

directions. 

12. Review the summary page for the New Network Dataset, 

select the text, copy it to the Windows clipboard, and paste it 

into a WordPad document. Save it as NW_ YYMMDD.rtf (i.e., 

year, month, day) in the \Utility folder.

13. Click Finish and click Yes to build dataset. Wait while the 

network dataset builds.

Adding the Network Dataset

The next steps add the network dataset to the map document so 

travel can be modeled.

1. Close ArcCatalog and restart ArcMap and open Burnaby1.

mxd.

2. Add Transport_Model_ND from the Transport_Model feature 

dataset in the GDBFiles folder. Do not add other participating 

feature classes. Move the network dataset below Highways, 

Streets and turn it off.

3. Right-click on the Streets - Slope layer and choose Zoom to 

Layer.

4. Enable the Network Analyst extension. Choose Tools > 

Extensions and check Network Analyst. Add the Network 

Analyst toolbar and dock it at the top of the map.

5. Make the Network Analyst Window visible by clicking the 

Show/Hide Network Analyst Window button on the Network 

Analyst toolbar.
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Setting Up Service Areas

The steps in this section create the service areas and load fire hall 

locations.

1. On the Network Analyst toolbar, click the Network Analyst 

drop-down and select New Service Area. Click the Properties 

button on the top of the Network Analyst Window and name 

this service area Optimized Travel NW, Slope.

2. Repeat this process to build a second service area called 

Optimized Travel NW, No Slope.

3. Create a new layer group, name it Optimized Travel NW 

Group, and drag and drop both service areas to add them to 

the group. Move Optimized Travel NW Group to the bottom 

of the TOC, above Slope, Percent, Hillshade JPEG. 

Loading Fire Hall Locations into the Network 

The following steps will be applied to both the no slope and 

slope network datasets to load the fire hall locations.

1. Change the network dataset in the Network Analyst Window 

drop-down to Optimized Travel NW, No Slope. Right-click on 

Facilities (0) and choose Load Locations. In the Load Locations 

dialog box, add the parameters shown in Table 4. Click OK. 

Facilities now shows (5) items. Expand the entry to see that 

fire halls 1, 3, 4, 5, and 7 have loaded.

Load the fire hall locations into the 
network and set the sort field as INDEX 
and the search tolerance at 200 meters.

Once the fire hall locations have been 
loaded, check that halls 1, 3, 4, 5, and 7 
are listed in the Network Analyst window.
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2. Change the Network Analyst Window drop-down to 

Optimized Travel NW, Slope. Using the same procedure and 

parameters, load fire hall locations into this dataset.

3. Save the map document.

Table 4: Fire hall location parameters.

Field Value

Load From Fire Halls

Sort Field Index

Name LABEL

Search Tolerance 200 Meters

Defining Travel Area Parameters 
for No Slope and Slope

1. Right-click on the Optimized Travel NW, No Slope layer in the 

TOC and choose Properties.

2. Click on each tab listed in Table 5 and change the settings 

as indicated. On the Analysis Settings tab, make sure the 

Impedance is set to Minutes_S (Minutes). This is an important 

parameter and it is not a default. Double-check these 

parameters and click Apply and OK.

3. Save the project.

4. Repeat these analysis selections for Optimized Travel NW, 

Slope service area.

5. Save the map document.

Table 5: Travel area parameters.

Tab and Parameters Setting

Analysis Settings Tab

Impedance Important: Use Minutes_S (Minutes) for 
Slope. 
Use Minutes_R (Minutes) for No Slope.

Default Breaks 10

Oneway Check Restrictions

Polygon Generation Tab

Generate Polygons Check

Detailed Select

Trim Polygons Check and Set Trim to 200 Meters

Multiple Facilities Options Not Overlapping

Overlap Type Disks (Not essential but a good habit)

Line Generation Tab

Generate Lines Check

Include Network Source Fields Check

Overlap Options Not Overlapping

Accumulation Tab

Minutes_S, Minutes_R, Length_Km Check

Solving

With all the parameters established for the network datasets, the 

network solver can be applied.

1. With the Optimized Travel NW, No Slope selected in the 

Network Analyst Window drop-down, click the Solve button 

on the Network Analyst toolbar. When the process is 

complete, five polygons will be added to the Network Analyst 

Window. Save the map document.
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2. Change the drop-down to Optimized Travel NW, Slope 

and use the same process as in the previous step. Save the 

document again. 

3. Turn off the Streets - Slope and Slope, Percent, Hillshade 

JPEG layers and turn the Optimized Travel NW, Slope and 

Optimized Travel NW, No Slope layers on. Inspect both 

network solutions to discern the differences between them.

4. Save the map document.

Joining Attribute Tables

Right-click on Polygons in the Network Analyst Window for 

either service area and open the attribute table. Notice the table 

contains a NAME field that lists the responding station and the 

10-minute maximum time. Open and inspect the Line attributes 

table for one of the service areas. Lines contain only a Facility 

ID for the related fire hall but no fire hall name. These network 

output file attribute tables will require tabular joins back to the 

Fire Halls layer attribute table.

1. Join the Fire Halls table with the polygon and line attribute 

tables to incorporate this data. Right-click on Polygons in the 

Optimized Travel NW, Slope layer in the TOC and choose 

Joins > Joins and Relates. Fill in values for the Join Data 

dialog box using the parameters in Table 5. Click OK.

2. Repeat this process for the lines in Optimized Travel NW, 

Slope and for polygons and lines in Optimized Travel NW, No 

Slope. It is clear now why the Fire Halls were indexed. Open 

the attribute tables to ensure the joins were made correctly. 

If not, right-click on the layer and choose Joins and Relates > 

Remove Joins.

3. Save the project.

After setting the travel area properties, click the Solve button to generate 
the service area polygons.
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Table 6: Join parameters.

Join Parameter Value

Field in this layer that the join will be 
based on

FacilityID

Table to join to this layer Fire Halls

Field in the table to base the join on INDEX

Exporting Travel Areas and Travel 
Networks to New Feature Classes

The results of a service area solver are stored in the ArcMap 

document. To share these results with others, network solutions 

can be saved as geodatabase feature classes or shapefiles.

1. Make sure ArcCatalog is closed. In the ArcMap TOC, right-

click on Lines in the Optimized Travel NW, No Slope layer and 

choose Data > Export Data.

2. Export All features using the layer's coordinate system. Click 

the folder icon button to browse to Burnaby_Fire.gdb 

\Transport_Model. Set Save as type to Personal and File 

Geodatabase feature classes. Name the file snetopt10_NS. 

Add the feature class to the map document.

3. Save the map document.

Table 7: Names for exported feature classes.

Network Analysis Layer Feature Class Name

Optimized Travel NW, No Slope, Lines snetopt10_NS

Optimized Travel NW, No Slope, Polygons sareaopt10_NS

Optimized Travel NW, Slope, Lines snetopt10_SL

Optimized Travel NW, Slope, Polygons sareaopt10_SL

Organizing and Symbolizing Travel 
Areas and Networks

After creating feature classes for the networks and areas, 

grouping and symbolizing them will make comparing them easier.

1. Minimize all layers and groups in the TOC. Create a new 

group and name it Optimized Travel Network Group. Place 

this group below Fire Halls.

2. Rename snetopt10_SL to Optimized Travel Network, Slope 

and drag it to the Optimized Travel Network Group.

3. Rename snetopt10_NS to Optimized Travel Network, No 

Slope and drag it to the Optimized Travel Network Group.

4. Create another new group, call it Optimized Travel Area 

Group, and place this group above the Travel NW Group.

5. Rename sareaopt10_SL to Optimized Travel Area, Slope and 

place it in the Optimized Travel Area Group.

6. Rename sareaopt10_NS to Optimized Travel Area, No Slope 

and place it in the Optimized Travel Area Group.
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7. Double-click on the Optimized Travel Area, Slope layer. Click 

the Symbology tab and click the Import button. Navigate to 

Optimized Travel Area.lyr in E:\02_ TESTDRIVE\Burnaby_1 

\GDBFiles\ UTM83Z10 to import its thematic symbology. 

Repeat this process for Optimized Travel Area, No Slope.

8. Use the same procedure to import the Optimized Travel 

Network.lyr symbology for Optimized Travel Network, Slope 

and Optimized Travel Network, No Slope.

Calculating Optimized Area for Each Fire Hall

Now summarize the characteristics of the optimized travel areas.

1. Open the attribute table for Optimized Travel Area, Slope and 

notice that each fire station has only one footprint polygon. 

The area is calculated in square meters. To label each polygon 

with the area in square kilometers requires only applying a 

simple math function and rounding.

2. Right-click on the Optimized Travel Area, Slope layer name 

in the TOC and click Label Features. Right-click on this layer 

again and select Properties. Click on the Label tab. Change 

the text symbol color to white, bold, and 12 points. Do not 

close this dialog box.

3. Click the Expression button. Type ROUND([Shape_

Area]/1000000,2) &” Sq Km” into the formula window. Click 

the Verify button to check the calculation and see a sample 

label. Click OK.

After generating the service areas and networks, use the layer files in the 
sample dataset to quickly symbolize these layers.
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4. Looking at the service areas, new Fire Hall 7 has the largest 

area (10.32 sq km) and Fire Hall 4 has the smallest (6.21 sq km). 

To effectively model response areas for all Burnaby fire halls 

would require building a complete three-dimensional street 

network and adding the other stations located outside of the 

study area.

Calculating Total Street Length 
Traversed by Each Fire Hall

Open the Optimized Travel Network, Slope attribute table. Note 

that each fire hall has multiple street segments. The Label field 

identifies which segments correspond with each station. The next 

step will be to summarize this data to assign total kilometers to 

each station.

1. Open the attribute table for Optimized Travel Network, Slope.

2. Right-click on the Label field and choose Summarize.

3. Summarize on LABEL. Under statistic to summarize on, scroll 

to the bottom of the list, expand Shape _Length, and check 

Sum.

4. Name the table snetopt10_SL_Sum1, specify that it is a File 

and Personal Database Table, and store it inside Burnaby 

_Fire.gdb.

5. Add the summary table into the map and open it. Notice 

that Fire Hall 5 protects nearly 98 km of streets while Fire 

Hall 4 protects only a little more than 50 km. (Note that the 

dataset was clipped for training purposes.) The new Fire Hall 7 

protects nearly 84 km of streets including a significant portion 

of Highway 1.

When complete, the map allows the service areas and fire hall 
locations to be easily compared visually.
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Conclusion

In this exercise, slope- and turn-adjusted time-based optimum 

response areas were used for carefully defining primary response 

areas for each fire hall and its neighboring stations. Modeling 

coverage for existing and proposed stations often requires 

running multiple models and summarizing value, hazard, risk, and 

protection within all station footprints for multiple scenarios. This 

requires a bit of work, but the results are very convincing.
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Coding and Counting
Joining and summarizing tables to add information

By Mike Price, Entrada/San Juan, Inc.

In the last issue of ArcUser, the tutorial “Slopes, Sharp Turns, 

and Speed—Refining emergency response networks to 

accommodate steep slopes and turn rules” showed how to 

model emergency service area coverage for existing and 

proposed stations using the ArcGIS Network Analyst extension.

In the previous exercise, a network dataset was created, its 

attributes and turn rules defined, and optimized service areas for 

fire halls were generated. Travel values, with and without slope 

adjustments, were calculated, and the optimized area and total 

street length for each fire hall were calculated. The exercise in this 

issue's tutorial builds on that project with an additional exercise 

showing how to map and count the hydrants and incidents in the 

optimized service areas that were previously generated.

The data for both exercises was supplied by the city of 

Burnaby, British Columbia, Canada. Burnaby, the third largest 

urban center in the province, is a major business, residential, 

and transportation corridor between Vancouver and British 

Columbia's Lower Mainland. Elevation ranges from mean 

sea level to 375 meters. Land features have controlled and 

constrained development throughout this community.

The Burnaby Fire Department serves the entire municipal area 

and provides aid response into neighboring jurisdictions. The 

department staffs six fire halls, and a new station will open soon. 

The agency's staff numbers 286 and, in 2006, responded to

This tutorial uses a stepped-down version of the map document created 
in the previous tutorial. The optimized travel areas in this tutorial will be 
spatially joined with hydrant and incident data and summarized by service 
area.
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 13,400 calls. The Burnaby Fire Department works closely with 

the city's Engineering Department to plan and optimize service 

throughout the area. Burnaby's Engineering Department uses 

ArcGIS Network Analyst to optimize response areas.

Getting Started

Download the zipped sample dataset for this exercise from 

ArcUser Online (esri.com/arcuser) and place it near the root of the 

drive that will contain the project. Unzip the data and explore it in 

ArcGIS ArcCatalog.

The archive should generate a directory structure that includes 

folders for geodatabase files (GDBFiles) and a utility folder 

containing Microsoft Excel spreadsheets that explain calculations 

that were incorporated in the previous exercise as well as a 

VBScript that assigns various penalties for different types of 

turns. The sample dataset also contains burnaby_2_sm.mxd, the 

ArcMap document that will be used in the exercise.

Adding Information 
Using Spatial Joins

This exercise explains how 

to map and code Burnaby's 

fire hydrants to specify the 

closest optimized fire hall 

and count the hydrants 

in the station's optimized 

response area.

1. Start ArcMap and open 

burnaby_2_sm.mxd.

2. Load Fire Hydrants Layer 

file from the Burnaby_

Fire.gdb in the GDBFiles 

> UTM83Z10 folder.

3. In the table of contents (TOC), right-click on Fire Hydrants and 

choose Joins and Relates > Join. In the Join Data dialog box, 

select Join data from another layer based on spatial location 

from the first drop-down. Click the second drop-down and 

choose Optimized Travel Area Slope.

4. The dialog box should indicate this will join polygons to 

points. Click the radio button next to It falls inside.

What You Will Need

•	ArcGIS Desktop 9.3 (ArcInfo, ArcEditor, or ArcView 

license level)

•	Sample data from ArcUser Online

Use a spatial join to combine hydrant 
point data with service area polygons.

http://www.esri.com/news/arcuser/1008/files/burnaby_2_sm.zip
http://www.esri.com/news/arcuser/1008/files/burnaby_2_sm.zip
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5. Click the Browse button. In the Save Data dialog box, change 

the Save as Type to File and Personal Geodatabase feature 

classes. Navigate to and save this new feature class in 

Burnaby_Fire.gdb as Fire_Hydrants_Halls. Click Save and click 

OK.

6. Right-click on the new Fire_Hydrants_Halls feature class and 

inspect its attribute table to verify that join was performed.

7. Remove Fire_Hydrants_Halls from the TOC. Right-click on 

Fire Hydrants in the TOC and choose Properties > Source 

and set the data source to Fire_Hydrants_Halls. Save the map 

document.

Counting Hydrants with Summarize

Summarizing on a field in a table can easily generate useful 

information about data. In this case, Summarize will be used to 

count the hydrants in each fire hall's travel area.

1. Open the Fire Hydrants attribute table and locate the Label 

field. Right-click on this field and select Summarize. To get 

only a count, don't specify any summary statistics. Save as a 

File Geodatabase table called Hydrants_Join_Sum1 and store 

it in the Burnaby_Fire.gdb.

2. Add the table to the map and check it. Based on the clipped 

street set, which Fire Hall is responsible for testing the most 

hydrants? (The answer is the 

new Fire Hall 7, which has 491 

hydrants.)

Updating Labels

The number of hydrants in each 

service area can be associated 

with the rest of the service area 

record by joining the summary 

table with the Optimized Travel 

Area Slope attribute table. Label each service area with the fire 

hall number and the number of hydrants it contains by joining the 

hydrant summary table using a simple VBScript.

1. In the TOC, right-click on Optimized Travel Area Slope and 

select Joins and Relates > Joins.

2. In the Join dialog box, choose Join Attributes from a Table. 

Set LABEL as the field to join. Choose Hydrants_Join_Sum1 

as the table to join to and choose LABEL field as the field in 

Hydrants_Join_Sum1 to base the join on. Choose Keep All 

Records and click OK. Accept indexing.

3. Open and inspect the Optimized Travel Area Slope table. 

Does each fire hall record now contain hydrant counts as 

attributes from Hydrants_Join_Sum1?

The resultant summary table 
reveals how many hydrants are 
maintained by each hall.
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4. A label expression has already been applied to label each 

service area with its area in square kilometers.

 Round( [sareaopt10_SL.Shape_Area] /1000000,2)&” Sq Km”

 Now add some additional script to include the number of 

hydrants in the label. Double-click on Optimized Travel Area 

Slope to open the Properties dialog box and select Labels > 

Expression. Add the following line to the end of the existing 

expression and click OK.

& VBNewLine & [Hydrants_Join_1.Cnt_LABEL] &” “&”HYDRANTS”

5. Save the map document.

Posting Emergency and Nonemergency Calls

In the United States, the National Fire Incident Reporting System 

(NFIRS) uses a three-digit numeric code to distinguish between 

emergency and nonemergency calls. Although the exercise data 

comes from Canada, NFIRS codes have been added to create a 

meaningful thematic legend and build summary statistics.

1. Turn off the Fire Hydrants layer. Load Incidents.lyr from 

GDBFiles > UTM83Z10 and inspect its symbology. These 

points represent responses by the Burnaby Fire Department 

to incidents that happened in 2007. This layer file applies a 

After creating a new feature class from the spatially joined data, 
summarize hydrants on LABEL field.

Add to the existing labeling expression to include the number of 
hydrants in each label.
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Quantities—Graduated Colors legend to display emergency 

and nonemergency calls by code value range. Table 1 lists the 

numeric ranges defined by NFIRS 5.0. These ranges will be 

used to build subsets of the 2007 calls. For a complete list of 

the NFIRS 5.0 codes and descriptions, download the NFIRS 

Reference Guide from www.nfirs.fema.gov/_download 

/NFIRS50CRG_011608.pdf. Chapter 3 contains detailed 

descriptions.

Table 1: NFIRS 5.0.

Inc_Code Range Description

100–199 All Fire

200–299 Rupture or Explosion

300–399 Rescue, EMS

400–499 Hazardous Condition

500–599 Service Call

600–699 Good Intent Call

700–799 False Call

800–899 Weather, Natural Hazard

900–999 Other or Special Incident

2. To separate the calls by type (fire, rescue and EMS, and 

other calls), make three copies of the master incident set 

and use three definition queries to separate the data. In the 

TOC, right-click on the Incidents Layer file and copy it. Right-

click on the Data Frame name and paste three copies of the 

Incidents.lyr. Rename the top copy to Fire, Explosion, Hazmat. 

Name the second copy Rescue, EMS. Name the third copy 

Other Calls. Turn off the Incidents Layer file and the copies.

3. Open the attribute table for Fire, Explosion, Hazmat. Click 

the Options button on the table frame and choose Select by 

Attributes. Create a new selection by typing the definition 

query

 (“INC_CODE” >=100 AND “INC_CODE”<300) OR (“INC_ 

CODE” >=400 AND “INC_CODE” <500)

 (shown in Table 2) in the text box and click Apply.

The Incidents Layer file symbolizes the NFIRS codes for Burnaby incidents 
in 2007. Make three copies of the Incidents Layer for the three categories 
of incidents.
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Table 2: Definition queries.

Layer Definition Query

Fire, Explosion, Hazmat (“INC_CODE” >=100 AND “INC 
_CODE”<300) OR

(“INC_CODE” >=400 AND “INC 
_CODE” <500)

Rescue, EMS “INC_CODE” >=300 AND “INC 
_CODE”<400

Other Calls “INC_CODE” >=500

4. Open the attribute table and sort on the INC_CODE field to 

verify that the definition query selected the correct records.

5. Right-click on Fire, Explosion, Hazmat and choose Data > 

Export. Save the selected features as a feature class called 

FEH in the Burnaby_Fire.gdb. Do not add this layer to the 

map.

6. Open the Properties dialog box for Fire, Explosion, Hazmat 

and change the data source to the FEH feature class.

7. Use the same procedure and the definition queries in Table 2 

to select records from the Rescue, EMS and Other Calls layers. 

Name the output feature classes RE and Other, respectively. 

Save the map document.

Joining and Summarizing Service Call Data

Counting the incidents for each fire hall's optimized response 

area requires spatially joining the service areas to the incidents, 

then summarizing on the calls. 

1. Right-click on Fire, Explosion, Hazmat in the TOC and choose 

Joins and Relates > Join.

2. In the Join dialog box, select Join data from another layer 

based on spatial location. Set the layer to join as Optimized 

Travel Area Slope. Change Save as Type to File and Personal 

Geodatabase feature classes. Save the new feature class 

inside Burnaby_Fire.gdb as Fire_Explosion_HazMat_Halls. 

Click OK. Remove this layer from the map document.Use definition queries to select incidents by NFIRS codes for each incident 
category, save the selected records for each category as a new feature 
class, and use the new feature classes as the data source for the incident 
layers.
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3. Double-click on the Fire, Explosion, Hazmat layer in the TOC 

and change the data source to Fire_Explosion_Hazmat_Halls, 

the new geodatabase feature class.

4. Repeat this process two more times. Create the Rescue_

EMS_Halls feature class by spatially joining the Rescue, EMS 

points to Optimized Travel Area Slope polygons. Create the 

Other_Calls_Halls by spatially joining Other Calls points with 

Optimized Travel Area Slope polygons. Remove these new 

layers from the map document and save the map document.

5. Summarize the incident for the selected sets in each layer 

using the same method employed previously with the 

hydrants data. Right-click on the Label field and choose 

Summarize. To get only the count, do not check any boxes 

in the Summarize dialog box. Save the output tables in the 

Burnaby_Fire.gdb as File and Personal Geodatabase tables 

named FEH_sum, RE_sum, and Other_sum, respectively. Add 

each table to the map and save the map document. 6. Load each summary table into the map document.

Which fire hall had the most rescues and EMS calls? Which fire 

hall had the fewest? With two engines, a ladder, and  

11 personnel, Fire Hall 3 has the most resources, but it also 

performs the most rescues.

Summarize the incidents for each layer on the LABEL field to learn how 
many incidents of each type were handled by each fire hall.
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Conclusion

This elaborate analysis assessed and validated public safety 

response capabilities for a major Canadian provider of fire and 

EMS services. The processes and workflow taught in this exercise 

are similar to those used by public safety analysts. ArcGIS 9.3 

facilitates and helps standardize this analytical process.
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Using 9.3 Functionality and Scripts
Calculating transportation network slope and travel parameters

By Mike Price, Entrada/San Juan, Inc.

Recent tutorials in ArcUser modeled time-based travel on steeply 

sloping streets in Burnaby, British Columbia. This exercise shows 

how new geometry calculation features in ArcGIS Desktop 9.3 

can be used for generating average slope values on short street 

segments from starting point to endpoint.

This calculation was used in “Slopes, Sharp Turns, and Speed—

Refining emergency response networks to accommodate steep 

slopes and turn rules“ in the Summer 2008 issue of ArcUser 

to adjust travel time on steep Burnaby hills. Slope values were 

provided as part of the exercise and were determined using 

third-party software and outside data management in an Excel 

spreadsheet.

However, with the Calculate Geometry function in ArcGIS 9.3, the 

x and y coordinates can be calculated for segment endpoints. 

These endpoints may be converted to two 3D point files and 

their elevation determined. Using the x, y, and z coordinates of 

endpoints and the segment length, approximate slope can be 

generated by dividing the change in elevation by the segment 

length—a simple ratio of rise over run. This procedure requires 

the ArcGIS 3D Analyst extension to create three-dimensional 

street segments. The rest of the calculations are handled using 

core functionality in ArcGIS Desktop 9.3.

This exercise uses a small portion of the data used in previous tutorials 
that modeled the service areas of the Burnaby Fire Department.
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A file supplied in the sample dataset for this exercise, Slope 

_Time_Formulas.rtf, contains all necessary formulas for this 

exercise. These formulas can be copied and pasted to eliminate 

typing and possible typos; just be careful with field selection 

and do not change field names without editing the appropriate 

scripts.

Getting Started

Download the sample dataset and unzip it in a folder. The 

training dataset is contained in a folder named Burnaby2 and 

includes a file geodatabase containing a feature dataset named 

Transportation_Model. Inside this dataset is a single feature class 

named Streets_Slope_Calc.

Open the table for this feature class in ArcCatalog and inspect 

the data fields. This dataset is a three-dimensional representation 

of the northwest part of the Burnaby streets used in a previous 

exercise but has six additional columns that will be used to store 

x, y, and z values for street segment endpoints. Because the 

elevation values require three-dimensional geometries obtained 

from a large TIN, this dataset was created using the high-

resolution Burnaby engineering TIN as a reference surface.

1. Close ArcCatalog, start ArcMap, and open a new map 

document. Load the Streets–Slope.lyr from \Burnaby2 

\GDBFiles\UTM83Z10\. If necessary, repair the data links by 

setting the data source to the Streets_Slope_Calc feature 

class. Save the map document as SlopeCalcu.

What You Will Need

•	ArcGIS Desktop 9.3 (ArcView, ArcEditor, or ArcInfo 

license level)

•	ArcGIS 3D Analyst extension

•	Sample data from ArcUser Online

http://www.esri.com/news/arcuser/0109/files/burnaby_2.zip
http://www.esri.com/news/arcuser/0109/files/burnaby_2.zip
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2. Zoom to the data extent and notice that all streets display as 

thin dark green lines. This line type suggests that they all have 

zero slope, but this exercise will fix that situation.

3. First, calculate the x and y coordinates of the segment 

endpoints by opening the attribute table for Streets_Slope_

Calc. Locate the Start_X field. Right-click on the field name 

and select Calculate Geometry.

4. Click the Property drop-down and select X Coordinate of 

Line Start. Notice that endpoint coordinates and centroid 

coordinates can also be calculated.

5. Because the data source and data frame use the same 

coordinate system, either coordinate system radio button can 

be clicked. Leave units as meters.

6. Repeat this procedure to calculate the Y Coordinate of Line 

Start for Start_Y, the X Coordinate of Line End for the End_X 

field, and Y Coordinate of Line End for the End_Y field.

7. Next, use Calculate Geometry once more to calculate the 

Length for the Length_Km field. Be sure to set units to 

kilometers. Save the map document.

Calculating START_Z and END_Z

Because the Calculate Geometry functions do not directly 

calculate start and endpoint elevations, we need to calculate 

them separately. This calculation requires that line segments 

be three-dimensional entities, built using a grid or a TIN. Verify 

that these lines are true three-dimensional vectors by inspecting 

the Shape field in the attribute table, which contains a value of 

Polyline ZM. If you wish, you may also view them in ArcScene.

Initially, the street network displays as thin green lines 
indicating a slope value of zero.
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1. Calculate Z values for endpoints using the advanced 

VBScript provided in Listing 1 in a Map Calculator window. Locate 

[Start_Z] and right-click its header. Select Field Calculator and 

check the Advanced box.

2. In the Field Calculator, check the Advanced box. In the Pre- 

LogicVBA Script Code window, type or paste the contents of 

Listing 1.

3. In the box below Start_Z=, type z. Click OK.

 dim pcurve as ipolycurve 

set pcurve = [shape] 

dim ppt as ipoint 

set ppt = pcurve.frompoint 

dim z as double 

z = ppt.z

 Listing 1: START_Z calculation.

4. Repeat this calculation for [End_Z] using the script in Listing 2.

 dim pcurve as ipolycurve 

set pcurve = [shape] 

dim ppt as ipoint 

set ppt = pcurve.topoint 

dim z as double 

z = ppt.z

 Listing 2: END_Z calculation.

5. Again, set the field value in the bottom window to z and click 

OK. (Hint: Preserve the advanced calculation, change “pcurve.

frompoint” to “pcurve.topoint,” and recalculate.) Save the 

map document. This procedure was provided by the ArcGIS 

3D Analyst development team.

Calculating Relative and Absolute Slope

With the x, y, and z coordinates calculated for the segment's start 

and endpoints, modeling relative slope is really quite easy. A 

combination of Pythagorean theorem and the rise over run slope 

formula will calculate percent slope between the two segment 

endpoints.

This procedure works well for short city street segments with a 

consistent slope. It does not work well for continuous looped 

features (although these can be split), long road intervals, or 

streets that traverse a sudden ridge or creek without a break. 

Investigations for the best ways to model these situations are 

ongoing.

Select [Slope1]; open another Field Calculator; and in the 

calculation window, type the expression in Listing 3.

(([End _ Z] - [Start _ Z]) / (([Start _ X] - 

[End _ X])̂ 2 + ([Start _ Y] - [End _ Y])̂ 2)̂ 0.5)*100

Listing 3: Calculate percent slope between two endpoints.
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Notice that some slope values are positive (uphill travel) and 

some are negative (going downhill). Remember that the best way 

to think of slope as a percentage is that each value represents the 

number of meters (or feet) traveled up or down along a consistent 

100-meter (feet) segment. Slopes of more than 6 percent require 

significant horsepower to travel up and considerable effort 

braking to go down.

Calculate absolute slope for the Slope_Abs field with the Field 

calculator, using the formula in Listing 4. Save the map document.

Abs ([Slope1])

Listing 4: Calculating absolute slope.

Now that the Slope_Abs field contains slope values, the street 

segments will be symbolized based on absolute slope.

After calculating the values for the absolute slope field, 
the street network will be symbolized based on values in 
the Slope_Abs field.
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Conclusion

This workflow demonstrates how new geometry calculation 

features in ArcGIS 9.3 can calculate endpoint coordinates. It also 

highlights three-dimensional data conversion and several uses for 

tabular joins.
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Convincing the Chief
Proving that time-based networks really work

By Mike Price, Entrada/San Juan, Inc.

This exercise models data from Fire District 37 in South King County, Washington, and re-creates two analyses to validate the district's 
time-based network travel model using the ArcGIS Network Analyst extension's Cost OD (Origin-Destination) Matrix.
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Many recent ArcUser articles have shown how to design, build, 

and run time- and distance-based travel networks for emergency 

response modeling. These model posted or customized speeds, 

global turn rules, and slope corrections. Previous articles 

assumed that the modeling parameters and analytical findings 

were correct.

This tutorial uses data from Fire District (FD) 37 in South King 

County, Washington, and re-creates two analyses that were 

recently performed by agency staff to validate the district's 

time-based network travel model. The ArcGIS Network Analyst 

extension's OD (Origin-Destination) Cost Matrix will be used to 

test and validate actual timed trial runs for several stations.

Previous tutorials that appeared in the July–September 2007, 

October–December 2007, and Summer 2008 issues of ArcUser 

can be used to review the ArcGIS Network Analyst modeling 

method and the concepts of distribution and concentration. 

These articles provide more information on how emergency 

responders use time as a response measure.

Getting Started

To begin the exercise, visit the ArcUser Online Web site at www 

.esri.com/arcuser and download the sample dataset for this 

tutorial. This is the fourth in a series using Fire District 37 data, so 

the parent folder is named FD37_4.

1. Unzip the archived sample dataset at or near the root 

directory of a local drive. The archive creates a folder called 

FD37_4.

2. Open ArcCatalog and explore the data in FD37_4. Notice 

that there are three subfolders named DBFFiles, SHPFiles, 

and Utility. All exercise data is registered in Washington State 

Plane NAD83 North Zone U.S. Feet (WASP83NF).

3. Inside SHPFiles, notice the WASP83NF folder. This shapefile 

subfolder contains several shapefiles and layer files that will 

be used in this exercise.

4. Inspect the DBFFiles folder and see that Time_Runs_1 

contains run data for four FD 37 fire stations, recorded at four- 

and eight-minute travel points.

5. Open RunSummary1.xls and see that it contains one 

worksheet, Statistical Summaries, that is ready to tabulate 

statistics for the four- and eight-minute runs for each station.

6. Leave ArcCatalog open. 

What You Will Need

•	ArcGIS Desktop (ArcView, ArcEditor, or ArcInfo license)

•	Microsoft Excel

•	ArcGIS Network Analyst extension

•	Sample dataset from ArcUser Online

http://www.esri.com/news/arcuser/0309/files/fd37_4.zip
http://www.esri.com/news/arcuser/0309/files/fd37_4.zip
http://www.esri.com/news/arcuser/0309/files/fd37_4.zip
http://www.esri.com/news/arcuser/0309/files/fd37_4.zip
http://www.esri.com/news/arcuser/0309/files/fd37_4.zip


Fire Mapping: Building and Maintaining Street Networks in ArcGIS June 2012 36Convincing the Chief

To gather data for this project, station duty crews at each station 

were instructed to drive 10 different routes from their station to 

locations on the street network. They drove the routes at speeds 

at or near accepted response speeds, in light to moderate 

daytime traffic, and in good weather. The apparatus officer noted 

the exact location of the four-minute and eight-minute time point 

on each route. These time points were then mapped and are 

available for this exercise as a dBASE table including WASP83NF 

coordinates.

Building a Network Dataset with 
Network Analyst 9.3

In ArcCatalog, verify that the Network Analyst extension is 

available and active.

1. Navigate to FD37_4/SHPFiles/ WASP83NF and locate streets 

_nw.shp. Preview the attribute table for this layer. Notice that it 

contains network-ready data including fields for a time cost in 

minutes, length in miles, and one-way flags. These fields will 

be used to build a network dataset.

2. In the Catalog tree, right-click streets_ nw.shp and select New 

Network Dataset. Accept the default name and click Next.

3. Inspect Connectivity and accept End Point as the only 

connector; click Next. The streets use geometry rather than 

elevation to define crossing relationships, so do not modify 

connectivity.

4. Click Next and accept Global Turns; click Next again.

5. In the network attributes window, click the Add button to add 

an attribute. In the new Add New Attribute dialog box, type 

Length_Mi for Attribute, choose Cost for Usage Type, choose 

Miles for Units, and leave Data Type as Double. Notice that 

Minutes and Oneway are both default parameters because 

the primary test will be fastest travel time, not the shortest 

distance.

In ArcCatalog, create a 
new network dataset.

Create a new attribute, 
Length_Mi, for this 
network dataset with Cost 
as the Usage Type and 
Miles as the Units.
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6. Highlight Minutes and click the Evaluators button. In the 

Evaluators dialog box, select the Default Values tab. For the 

Turn element, click on the word Constant to see four options. 

These options now include a new one in ArcGIS 9.3 called 

Global Turn Delay. Select this option and press F12.

7. A new Global Turn Delay Evaluator appears. Notice that 

this evaluator supplies defaults but allows modification of 

the intersection approach angles and the delay times. Also 

notice that feature classes can be used to create complex 

relationships between different street classes.

8. Save the map document.

The streets in this sample dataset are rather simple and will only 

require the use of one Local class. The Seconds field in this 

dialog box accepts values for delays for straight travel (with and 

without crossing roads), right and left turns, and U-turns. After

tuning the streets in the sample dataset, it was determined that 

the delays shown in Table 1 work best throughout the district.

Set the Seconds delays field values in the Global 
Turn Delay evaluator as shown here and listed in 
Table 1.

Set the default values for the Minutes evaluator 
and use the new Global Turn Delay for the type 
of turn.
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Table 1: Delay values.

Direction Description Sec

Straight From Local to Local Road 
across No Roads

0

Straight From Local to Local Road 
across Local Road

1

Reverse From Local to Local Road 3-

Right Turn From Local to Local Road 2

Left Turn From Local to Local Road 4

To add these values to this project, type the values for 

these delay values into the Seconds field, or load a prebuilt 

XML time set from the \Utility folder created by the sample 

dataset archive. To load the XML file, click the Load From 

File button on the dialog box, navigate to \Utility, and select 

GlobalTurns_00_01_02_04.xml. The optimal values will post 

automatically.

Turn window width can be changed interactively. After using the 

mouse to resize portions of the colorful azimuth graphic, reset or 

retype Width values (in degrees) to restore the defaults or reload 

the XML file. Click OK to close the Global Turn Delay Evaluator, 

click OK to accept the updated Evaluators, and click Next. Accept 

Driving Direction defaults and click Next again.

A summary of the network dataset parameters that have been 

set appears in a scrolling window. Select and copy this text into a 

WordPad file. Name the file with the creation or last modification 

date and save the text file in the \SHPFiles\WASP83NF folder. 

Inspect this file carefully and observe the new global turn rules.

Click Finish, then Yes to build the new network dataset. Once this 

is completed, close ArcCatalog and open ArcMap.

Loading and Mapping Network 
Streets and Time Runs

In ArcMap, open the FD37_SOC4 ArcMap document file located 

in the FD37_4 root folder. Inspect this map document. The 

data is very similar to data used in previous District 37 tutorials. 

However, in this case, only three stations appear. These stations 

were selected to show variety within the district. The project 

opens in Layout View and shows location, apparatus, and staffing 

for Stations 71, 74, and 76. The Time Runs layer, at the top of the 

TOC, does not have a valid data connection. At the end of this 

next process, that problem will be fixed.

Station 71 is an engine/squad station with five on-duty personnel. 

It is located just south of the Kent downtown area. Station 74 

includes a ladder, a squad, and a battalion chief (six personnel), 

located on high ground in eastern Kent. It is situated on an 

arterial street and much of the surrounding land use is residential. 

Station 76 is a three-firefighter engine station located in the 

northern Warehouse district. 
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1. Before adding data to the project, confirm that the Network 

Analyst extension is available and its toolbar is visible.

2. Open an empty Network Analyst Window. Click the Add Data 

button on the Standard toolbar and navigate to \SHPFiles\ 

WASP83NF.

3. Load the network dataset streets_nw_ ND. When prompted, 

do not load other participating feature classes.

4. In the TOC, drag streets_nw_ND below the Network Streets 

and turn it off.

5. Navigate to the \DBFFiles folder and load Trial_Runs_1.dbf.

6. Open the table for this file and locate the East and North 

fields. Using these and applying the correct Washington State 

Plane coordinates, the data can be registered.

7. In the TOC, right-click Trial_Runs_1. dbf and choose Display 

XY Data. Set the X Field to East and the Y Field to North. Click 

Edit.

8. In the Spatial Reference Properties dialog box, click Select 

and specify NAD_1983_State Plane_Washington_North 

_FIPS_4601_Feet from the choices under Projected as the 

coordinate system. Click OK and OK to exit both dialog 

boxes.

9. After Trial_Runs__1Events loads, rightclick on it and choose 

Data > Export Data. Apply the data frame's coordinate 

system, name it Trial_Runs_1.shp, and store the file in  

\SHPFiles\WASP83NF. Do not add the shapefile to the data 

frame.

10. Next, double-click on Time Runs, the layer that has a broken 

data connection, and set Trail_Runs_1.shp as its data source. 

Remove Trial_Runs__1Events.

Create an events layer from 
Time_Runs_1. dbf and export 
the georeferenced data to a 
shapefile.
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11. Make the Trial Runs layer visible and inspect its points. Each 

point is labeled to show the station, time interval, and run 

code. Switch from Layout View to Data View.

12. Save the project.

Building and Solving an OD Cost 
Matrix for Station 71

The next task will be building three origin-destination matrices—

one for each station and its time run data. There are many ways 

to build and analyze this run data, but creating a separate matrix 

for each station will allow quick viewing of statistical data for each 

time subset. There are more sophisticated ways to model and 

present this data, but this exercise uses a simplified approach. 

After creating the matrix for Station 71, the process will be 

repeated for Stations 74 and 76.

1. Be sure that the Network Analyst toolbar and window are 

available. Click on the Network Analyst drop-down in the 

toolbar window and choose New OD Cost Matrix.

2. In the TOC, right-click on OD Cost Matrix (just created) and 

select Properties. In the General tab, rename the layer Station 

71. Click the Accumulation tab and check the Length 

_Mi and Minutes boxes. In the Analysis Settings tab, verify that 

Impedance is set to Minutes.

In the Selected Fire Stations table, select the only record for Station 71. In 
the Trial Runs table, use an attribute query to highlight all 22 records for 
Station 71.



Fire Mapping: Building and Maintaining Street Networks in ArcGIS June 2012 41Convincing the Chief

3. Open attribute tables for Time Runs and Selected Fire 

Stations layers. In the Selected Stations table, select the only 

record for Station 71. In the Trial Runs table, use an attribute 

query to highlight all 22 records for Station 71.

4. In the Network Analyst window, right-click on Origins and 

select Load Locations. In the Load Locations dialog box, set 

Sort Field to INDEX. For the Name Property, click on Field 

and choose LABEL. Under Location Position, choose Use 

geometry and specify 500 and Feet for the search tolerance. 

Click OK. Verify that the single Station 71 record in Selected 

Fire Stations is selected.

In the Load Locations dialog box for Selected Fire 
Stations, set Sort Field to INDEX, set the field for 
Name property as LABEL, and under Location 
Position, choose Use Geometry and specify 500 
and Feet for the search tolerance.

In the Network Analyst window, load 
the locations in the OD Cost Matrix for 
Station 71 by right-clicking on Origins 
and choosing Load Locations.
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5. Right-click on Destinations, choose Load Locations, and 

select the 22 records for Station 71 selected in the Trial 

Runs attribute table. In the Load Locations dialog box, set 

Sort Field to INDEX and the Name property field to LABEL. 

Be sure that the correct (i.e., selected) 22 records load. If 

non-Station 71 records load, delete them and reload the 

correct ones. (Note: Do not delete records when modeling 

Concentration because the tabular join to INDEX, necessary 

for this operation, will fail.)

6. Create new OD Matrices for Stations 74 and 76 using this 

procedure. Be sure to select and load the correct origin and 

destination records. Rename each OD matrix and group all 

matrices in one group layer named OD Cost Matrix Group.

7. Save the project.

Solving and Analyzing OD Cost Matrix Results

The three matrices are now ready to solve.

1. In the OD Matrix group, right-click on the matrix for Station 71 

and select Solve. Under Destinations, Lines will be populated.

2. Right-click on Lines, choose Properties, and use the General 

tab to rename it Station 71. Using Properties, also change 

the line width to a three-point width and apply bright distinct 

colors.

3. Repeat this process for the Station 74 and 76 matrices.

4. Save the map document again.

Right-click on Destinations, choose Load 
Locations, and select the 22 records for  
Station 71 selected in the Trial Runs attribute 
table. In the Load Locations dialog box, set Sort 
Field to INDEX and the Name property field to 
LABEL.
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This exercise builds two-node vector lines that show the 

connection between a fire station and its trial run points. Network 

Analyst actually posts the shortest travel time and route distance 

in the Lines table. Although the route is represented by a straight 

line, it actually follows the fastest network.

1. Under the OD Cost Matrix group, right-click on the Lines 

solution for each station and open its attribute table. Stack 

the tables. Select the four-minute records for each station by 

querying out records with Total_Minutes less than 5.0.

2. To quickly tabulate and display statistics for each station's 

four-minute runs, locate and right-click on each table's Total 

_Minutes field and choose Statistics. 

Under the OD Cost Matrix group, right-click on the Lines 
solution for each station and open its attribute table. 
Stack the tables.

To quickly tabulate and display statistics for each station's four-minute 
runs, locate and right-click on each table's Total_Minutes field and choose 
Statistics.
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3. Inspect the statistics for the sub-four-minute runs for each 

table, particularly the Mean and Standard Deviation values. 

It certainly would be nice to place this data in a table so it 

could be studied. To quickly post this summary data, open the 

Excel spreadsheet template, RunSummary1.xls, provided in the 

sample dataset, and copy values from the four-minute statistics 

generated for each station to the appropriate cells in the 

spreadsheet.

In ArcMap, under the four-minute statistics for Station 71, copy 

and paste the Mean value from the summary spreadsheet to 

the Mean, Minutes field in the attribute table for Station 71 in 

ArcMap. Repeat for the Run Count; Maximum, Minutes; Minimum, 

Minutes; and Standard Deviation fields. Gather the same 

statistical data for Stations 74 and 76.

To generate statistics for the eight-minute run data for each 

station, simply click the Options tab on the table for each station 

and choose Switch Selection. Copy and paste the eight-minute 

run statistics into the spreadsheet.

Now that the time Runs for three District 37 fire stations have 

been summarized, inspect RunSummary1.xls. Notice that the 

mean values for all four- and eight-minute runs are very close 

to the target times. In each station's travel area, the average 

actual time is very close to the targets. Each station's dataset 

includes records that represent times greater than and less than 

the targets. Smaller standard deviation values suggest tighter 

clustering around the mean. In general, District 37 managers are 

very satisfied with the performance of this travel network. These 

trial runs have shown that slightly liberal turn rules and posted 

speed are valid measures of emergency response capability.To quickly post this summary data, open the Excel spreadsheet template, 
RunSummary1.xls, provided in the sample dataset and copy values from 
the four-minute and eight-minute statistics generated for each station to 
the appropriate cells in the spreadsheet.
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Summary

This exercise used the Network Analyst OD Cost Matrix to 

compare actual measured travel times to modeled values. Overall, 

this analysis demonstrated a very good correlation between 

modeled and actual times. District 37 personnel continue 

assessing travel times and testing additional details that might 

improve the response model. As a corollary to this exercise, 

District 37 has also recognized the potential to use an OD cost 

matrix to test and validate actual travel times to specific incidents.
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Do It Yourself!
Building a network dataset from local agency data

By Mike Price, Entrada/San Juan, Inc.

Tutorials in recent issues of ArcUser magazine have showed how 

to create mapped time- and distance-based travel network 

models for emergency response applications. Building these 

models required carefully prepared agency or commercial street 

data that had been tuned for network modeling.

Many local agencies build and maintain quality street datasets, 

often designed to support highly reliable geocoding. While these 

streets can be very current and have great positional accuracy, 

they are often not built to support time- and distance-based 

networking. However, in many cases, it is possible to modify 

these street datasets to support a network model.

This exercise uses a street dataset for Redlands, California, 

where Esri is headquartered. The Redlands City GIS streets data 

was designed and is maintained for address geocoding. After 

inspecting the data, the exercise explores several methods for 

modifying a copy of the data for time-based networking. This 

exercise involves careful heads-up editing. The Redlands street 

data in the sample dataset has been modified only slightly so 

exercise tasks can be accomplished more quickly. It is very similar 

to the original Redlands street dataset.

This article assumes a basic understanding of ArcGIS Desktop 

and the ArcGIS Network Analyst extension. To review modeling 

travel networks with ArcGIS Network Analyst and the concepts 

of distribution and concentration, please read and work the 

exercises published in the July–September 2007, October–

December 2007, and Summer 2008 issues of ArcUser and 

available online at esri.com/arcuser. These articles provide 

This exercise explores several methods for modifying street data for use in 
time-based network modeling.

http://www.esri.com/arcuser
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background information on how emergency responders use time 

as a response measure.
Getting Started

To obtain the sample dataset for this exercise, and download 

doityourself.zip. This file contains all the data necessary to 

perform this tutorial. Unzip this data archive near the root 

directory on your hard drive. In Windows Explorer, right-click on 

the Redlands folder; choose Properties; and on the General tab, 

make sure Read Only is unchecked.

Open ArcCatalog and navigate to the Redlands folder. Preview 

the data in Geography and Table modes. Notice that the data is 

in California State Plane North American Datum of 1983 (NAD 83) 

Zone V and units are U.S. Survey Feet. Preview the Redlands01 

.mxd file to see the study area for the exercise.

Locate and carefully inspect the streets shapefile. This geocoding 

dataset was created and maintained by the City of Redlands. To 

protect the original file, make a copy of streets_in and rename 

it streets_nw. The copied file, streets_nw, will be used for this 

exercise.

Adding Fields for Results

While in ArcCatalog, add three attributes to support the network 

model. Preview the streets_nw attribute table. In the Catalog 

tree on the left, right-click on streets_nw, choose Properties, and 

click the Field tab. Notice that the lowermost (rightmost) field in 

the source table is ADDRCITY. The three new fields will support 

directional time and distance networking.

What You Will Need

•	ArcGIS (ArcView, ArcEditor, or ArcInfo license levels)

•	ArcGIS Network Analyst extension

•	Sample data from ArcUser Online

file:http://www.esri.com/news/arcuser/0609/files/doityourself.zip
file:http://www.esri.com/news/arcuser/0609/files/doityourself.zip
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1. Click the first blank line in the Field Name column and name 

the first new field OneWay. Specify the data type as text and 

the field length as four characters. Click Apply. This field will 

be used to code travel direction for all one-way streets.

2. Click in the next blank name field and type “Length_Mi.” 

Specify a Double format with a Precision of 12 and a Scale 

of 6. Click Apply. When the length of each street segment 

is calculated in decimal miles later in this lesson, this field 

will hold those results. These values will be used to calculate 

travel time for all segments.

3. Add a third field; name it Minutes; and set its type to Double, 

with a precision of 12 and a scale of 6. This field stores 

calculated travel times for each segment. Click Apply and OK. 

Close ArcCatalog.

Examining Distance and Speed, 
Street Class, Street Type

Start ArcMap, turn on the Network Analyst extension, and make 

the Network Analyst toolbar visible. Open Redlands01.mxd and 

verify that all data layers have loaded properly, including the two 

layers that display the network streets. The Streets with Speed 

layer will be visible and the Streets with Speed and Direction 

layer will be unchecked. Double-click on any layers that have a 

red exclamation point, choose Properties > Source, and click Set 

Data Source to repair the path to the data.

Switch from Layout View to Data View and open the attribute 

table for the Streets with Speed layer. Study all the fields for this 

layer.

Verify that the three new fields are available and contain either 

zero values or no text. Inspect all fields and look for information 

that will support geocoding and a time/distance network. This 

dataset contains speed limit [SPEED_MPH], street class [CLASS], 

and school zone [SCHOOLZONE] fields that can participate in 

the network. However, it does not contain any numeric values 

for distance. The TYPE field provides clues that it contains some 

directional streets. Select fields where [TYPE] = 'FRWY' or [TYPE] 

 = 'RAMP' and notice that these records do not contain 

geocoding attributes. They can be edited without upsetting the 

geocoding fields.

Impedance—Distance

Notice that there is no distance field in the source dataset. The 

Length_Mi field added earlier needs to be populated, but before 

calculating street segment lengths, many of the freeway vectors 

need to be edited.

Impedance—Speed

Sort the [SPEED_MPH] field in ascending order and carefully 

review the values. Notice that nine records have 0 speed limit. 

Before building the network, these records must be updated or 

deleted. Just remember that they are now in the street dataset. 

The [SPEED_MPH] field will provide the primary impedance and 
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a zero speed will not contribute to a meaningful time. Once 

directionality and connectivity issues are resolved, the segment 

length in miles and travel time in minutes can be calculated.

Crossing Relationships

Because this is a geocoding dataset, it does not contain fields 

for nonintersecting crossings (which are also called z-elevations). 

Although two z-elevation fields could be added to this table, it 

would require careful editing of all the values for each crossing 

and intersecting street segment—a complex, time-intensive 

process. Instead, geometry—not attribution—will be used to 

define and manage crossing relationships.

Connectivity

To properly create a network, all street segments must share 

common endpoints. Make the Streets with Speed layer 

selectable and zoom in or use the Magnifier Window to inspect 

intersections. Select street segments to verify connectivity. 

Notice that even freeway interchanges display connectivity where 

they cross city streets. Later in the exercise, freeway segments 

will be spanned across city streets to limit connectivity.

Directionality

Open the Layer Properties dialog box for the Streets with Speed 

layer, click on the Display tab, and set the transparency for the 

layer to 70 percent. Turn on the Streets with Speed and Direction 

layer. Zoom in and inspect streets near the I-10 and I-210 freeway 

interchange. Study the endpoint arrows and notice that not all 

segments are properly oriented for right-hand travel. This must 

be fixed. The OneWay field will be used to code all one-way 

segments.

Turns and Turn Relationships

Turns and intersection slowdowns are important in a time-based 

network. After updating streets in the next section, the next 

step will be building a network using global turns. Save the 

Redlands01.mxd before going on to the next section.

This exercise will limit connectivity by merging freeway segments 
across city streets. These selected examples show connectivity.



Fire Mapping: Building and Maintaining Street Networks in ArcGIS June 2012 50Do It Yourself!

Editing the Streets with Speed and Direction Layer

Open the Editor toolbar by choosing View > Toolbars > Editor, 

and choose Start Editing from the drop-down to start an editing 

session. Use the Selection tab in the table of contents to make 

only the Streets with Speed and Direction layer selectable.

Speed Limits

Open the attribute table for the Streets with Speed and Direction 

layer and inspect the new fields (Length_Mi, OneWay, Minutes). 

Locate all records where SPEED_MPH = 0. Zoom to and inspect 

each record. Decide whether to increase the speed limit or delete 

the record. If the choice is increasing the speed limit, use 10, 15, 

or 20 mph. (Hint: Delete Redlands Mall and Santa Ana Wash; set 

all other speeds to 10 mph.) Save the map document.

Directionality

Now to properly orient all freeway and ramp street segments. 

There are several segments of one-way streets in downtown 

Redlands that will be validated.

1. Before beginning an editing session, set a sticky move 

tolerance that will prevent accidentally moving a segment 

while modifying its orientation. In the Editing toolbar, select 

the Editing drop-down and open Options. Set the snapping 

tolerance to 50 feet and the sticky move tolerance to  

100 pixels.

Delete 
Redlands 
Mall and 
the Santa 
Ana Wash; 
set all other 
speeds to 
10 mph.

Set the snapping tolerance to 50 feet and 
the sticky move tolerance to 100 pixels.
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2. Close the attribute table for Streets with Speed and Direction 

and zoom in to the freeway interchange area. Study the 

segments displaying directional arrows. In the Editor toolbar, 

set the editing target as the Streets with Speed layer (which is 

a nonselectable layer) and specify the task as Modify Feature. 

Select an improperly oriented street segment. Notice that 

the red node also shows the downstream end of the selected 

segment.

3. To flip a segment, verify that the nodes are displayed and 

select the Edit tool (this tool has a black arrowhead icon and is 

usually located to the right of the Editing toolbar drop-down).

4. Carefully position the mouse cursor near the line's midpoint. 

(Hint: Look for the small x.)

Set the editing target to Streets with Speed and Direction and specify 
the Modify Feature task. Select an improperly oriented street segment 
and notice that the red node also shows the downstream end of the 
selected segment.

Carefully position the mouse cursor tip near the line's 
midpoint. (Hint: Look for the small x.) Right-click and select 
Flip from the context menu. Watch as the red leading node 
swaps ends, indicating that the line has reversed direction.
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5. Right-click and select Flip from the context menu. The red 

leading node swaps ends with the arrow, which indicates the 

line has reversed direction. Deselect this line.

6. Inspect all freeway and ramp segments and flip all improperly 

oriented segments. Caution: Be careful not to move any 

segments. If you think that you might have moved a segment, 

go to the Editor drop-down and choose Undo Move to return 

the segment to its original location.

7. Save edits about every 10 flips. (Hint: Use the shortcut keys to 

navigate the map more rapidly: C to pan, Z to zoom in, and X 

to zoom out.)

8. Check the Task window on the Editor toolbar to be certain 

that it displays Modify Feature. It will probably take 20 to  

30 minutes to flip all segments.

The city streets in Redlands that show directionality are properly 

oriented. Inspect street segments carefully to ensure this. If you 

accidentally flip a correct segment, simply flip it back. Check 

all on-ramps and off-ramps and watch out for a rest area on 

eastbound I-10. A OneWay code will be assigned to several 

ramps. Save the edits and the map document.

Crossing Relationships

In the next process, certain freeway and ramp segments will be 

merged to build correct crossing relationships. Do not perform 

this step before all appropriate directional segments are properly 

oriented.

A properly oriented network.
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Reopen an edit session and zoom to the I-10/I-210 interchange. 

Verify that only the Streets with Speed and Direction layer is 

selectable. Inspect all directional vectors. Use the Select Features 

tool to individually select several directional vectors.

Because all directional vectors share endpoints with other 

segments, a network built with these segments would maintain 

correct one-way travel, but might include segments that would 

make sharp turns from a limited-access travel lane onto crossing 

freeways and even city streets. This is not good.

Crossing geometries will help fix this issue. Simply stated, 

where a limited-access travel lane intersects another class of 

noncontinuous line segments, the limited-access segments will 

be merged to create a single crossing element. If two limited-

access segments merge into one, which happens with on- and 

off-ramps, these segments will not be merged.

In the interchange area, study these crossing relationships 

carefully. Using the Select Features tool, highlight two or more 

continuous segments that make up a ramp in this area. Do not 

select any line segments that cross the ramp segments being 

selected. Zoom in to make certain all segments for that section of 

ramp are selected. Select elements by beginning at one end of a 

section of continuous segments and select them in the direction 

of travel.

In the Editing toolbar, click the Editor drop-down and select 

Merge. Explore the Merge list and verify that all segments 

have the same source name. If the Merge dialog box contains 

more than one feature name, cancel the task and reselect the 

segments. Click OK to merge the segments and inspect the 

results.

There should be only one arrowhead, pointing onto I-10 in 

an easterly direction. Continue the process of merging line 

segments for all ramps that cross in this interchange, including 

freeway roadways and ramps.

If incorrect segments are accidentally merged, immediately use 

the Undo button on the standard toolbar to correct this problem. 

Zoom in and pan as necessary and save the map document 

frequently.

When all crossing freeway and ramp segments in the I-10/I-210 

interchange have been merged to form single crossing elements, 

follow the rest of I-10 and I-210 and merge all these segments 

also to create single crossing elements. Watch the directional 

arrow and the red endpoint symbol while merging segments. If 

an endpoint lands in the middle of a merged segment, undo the 

merge, check directionality, and change the segment selected 

in the Merge dialog box. If segments in an interchange contain 

speed limit changes, merge only segments with the same speed 

limit.

Remember not to merge any segments across valid limited-

access intersections. Undo the selection immediately to correct 
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any accidental merges. Advanced users can use the Split tool to 

disconnect segments when needed.

After completing all merging operations, inspect all freeway 

lands and ramps. Several ramps are problematic. It is difficult to 

tell if the feature being merged is part of an interchange or part 

of a crossing relationship. (Imagine how helpful high-resolution 

imagery would be.) When finished, stop editing, save edits, and 

save the map document. Now, length for all Redlands streets can 

be calculated and OneWay attributes can be assigned.

Editing Attributes

Now segment lengths and travel times can be calculated and 

directionality codes assigned to the OneWay field.

1. Make Streets with Speed and Direction nonvisible, set 

transparency at 0 for Streets with Speed, and make Streets 

with Speed the only selectable layer. This layer displays all 

records in streets_nw.

2. Open its attribute table, locate the Length_Mi field, and click 

on its field header.

3. Select Calculate Geometry and specify Property: Length. Use 

the coordinate system for the data frame and specify units as 

Miles U.S. Click OK to calculate all segments.

4. With length in miles, travel time in minutes can now be 

calculated. Open the Field Calculator. Select the MINUTES 

field and type the following in the formula box:

 [Length_Mi] * (60/ [SPEED_MPH])

 Click OK and check the calculations.

With length in miles, calculate travel time in minutes. Select the minutes 
field, type [Length_Mi] * (60/ [SPEED_MPH]) in the formula box, and click 
OK.
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5. Now, assign a OneWay code to all limited-access streets. 

Close the Streets with Speed attribute table and open the 

Streets with Speed and Direction attribute table. This layer 

also references the streets_nw shapefile, filtered to show only 

limited- access streets and a subset of Redlands streets.

6. Create a query that shows only streets where Type = 'FRWY' 

or Type = 'RAMP'. Use the Field Calculator to populate the 

OneWay field for each selected record with the value FT (a 

code for From-To). Because directionality has been carefully 

managed for this data, these codes can be applied for all the 

limited access dataset.

7. Assign an FT code to five specific Redlands city streets by 

creating a query where “TYPE” = 'ST' AND “NAME” = 'STATE' 

AND “PREFIX_DIR” = 'E' AND “LEFT_FROM_” <500. Use 

Field Calculator again to place an FT code in the OneWay 

field for these five records.

Redlands streets are now ready to be used for building a 

time-based network. Zoom to the data extent, save the map 

document, and admire the project.

The tasks in this exercise might seem a bit rigorous, but these 

steps were necessary to create a quality network source without 

compromising the data. Save this enhanced dataset for future 

activities.

Create a query that shows only streets where Type = 'FRWY' 
or Type = 'RAMP' and use the Field Calculator to populate 
the OneWay field with the FT (From-To) code for each 
selected record.
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Summary

In previous exercises, the ArcGIS Network Analyst extension was 

used to model time and distance response from fixed facilities. 

Experiment with this network street dataset by creating a network 

dataset from it and using it to work the Routes and Service Areas 

exercises in previous ArcUser articles in this series, noted at the 

beginning of this article.

Acknowledgments

Thanks go to Tom Patterson, Esri public safety specialist, for 

requesting this exercise and obtaining the Redlands data. Special 

thanks also go to the Redlands GIS staff members for providing 

this excellent dataset and allowing me to prepare and use it for 

this exercise.

(This article originally appeared in the Summer 2009 issue of ArcUser.)

http://www.esri.com/news/arcuser/0609/files/doityourself.pdf
http://www.esri.com/news/arcuser/0609/files/doityourself.pdf


Fire Mapping: Building and Maintaining Street Networks in ArcGIS June 2012 57Run Orders

Run Orders
Modeling and mapping public safety arrival orders

By Mike Price, Entrada/San Juan, Inc.

Timely integrated response to emergencies limits suffering 

and damage. GIS helps responding agencies provide better 

service. This is the last in a series of articles, which began in the 

October–December 2006 issue of ArcUser magazine, that have 

demonstrated how fire departments can model service areas and 

response using the ArcGIS Network Analyst extension.

Run orders allow a public safety agency to predict and map 

the arrival sequence and times for responders traveling to an 

incident from multiple locations. Previous exercises in ArcUser 

used optimized travel areas generated using the ArcGIS Network 

Analyst extension to identify the station from which the first 

responders (i.e., First Due) will arrive for a given location. By 

sequentially remodeling each First Due provider, Second Due 

coverage areas can also be mapped. 

Response modeling beyond Second Due coverage areas has 

always been difficult. In “Do It Yourself—Building a network 

dataset from local agency data,” which appeared in the Summer 

2009 issue of ArcUser, a sample dataset for the city of Redlands, 

California, was modified so it would support time-based travel 

modeling with ArcGIS Network Analyst 9.3.

Working this exercise requires a basic understanding of ArcGIS 

Desktop and the ArcGIS Network Analyst extension. To review 

modeling travel networks with ArcGIS Network Analyst, including 

information on distribution and concentration, and to work other 
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exercises in this series, visit the Learn How to Model Networks 

page (www.esri.com/news/arcuser/avmodel.html).

This exercise extends the street data that was enhanced in the 

previous exercise to include information about arrival orders and 

times for up to five emergency responders. In addition, areas 

where First Due coverage is within national standards will be 

identified and backfilled response analyzed when the nearest 

provider is already on a call. To ensure safe, quick entry into a 

structure by responders, the time lapse between arrival of the 

first and second units will be determined.

This tutorial shows how to model and map arrival orders for four 

fire stations near Esri's headquarters in Redlands, two western 

stations in the nearby city of Loma Linda, and one station to the 

east of Redlands in Mentone. It involves a complex workflow 

Run orders model response scenarios. This map shows the approximate 
time interval that the first crew on scene will wait for the second crew to 
arrive.

This tutorial models response from fire stations in and near Esri's 
headquarters in Redlands, California.

http://www.esri.com/news/arcuser/avmodel.html
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that includes definition queries, tabular joins, field and geometry 

calculations, and data exports. It requires great attention to detail.

Instead of using the dataset produced when working the 2009 

Summer issue exercise, use the sample dataset for this tutorial 

available from ArcUser Online. It has been converted from 

shapefiles to a file geodatabase and contains several additional 

fields that support run orders, and the network dataset used will 

be built inside a geodatabase feature dataset. Even though the 

sample dataset is small, you will need at least 500 MB of hard 

drive space to complete this exercise. Also note that the Closest 

Facility solution is complex and will take some time to solve.

Getting Started

Download the sample dataset, Redlands.zip, from ArcUser Online, 

which contains all the data necessary to perform this tutorial. 

Unzip Redlands.zip near the root of your project folder and open 

its contents in ArcCatalog. Navigate to the Redlands folder, 

expand the Redlands_Fire geodatabase, and preview the Run_

Order_Model feature dataset in Geography and Tablemodes. 

As in the previous exercise, the projected coordinate system is 

North American Datum (NAD) 1983 California State Plane Zone V, 

and the unit of measure is the U.S. Survey Foot.

Preview the feature class named Network_ Streets, as shown. 

Notice this street data is very similar to the street data used in 

the exercise in the last issue. With Network_Streets selected, 

switch to table view and explore the table structure. Scroll to the 

fields on the right side and note the new fields: INDEX, CENT_X, 

CENT_Y, STAT_01, and TIME_01. All fields contain zero values but 

they will soon be populated with the arrival order and times for 

the five closest stations.

Building the Network Dataset

The next step is building the Redlands Network_Dataset in 

ArcCatalog.

1. Right-click on Run_Order_Model and select New > Network 

Dataset. Accept the default name, Run_Order_Model_ND, for 

this feature class.

2. Continue through the Network Dataset wizard, accepting 

defaults until you get to the wizard pane for specifying 

attributes for the Network Dataset. With Minutes selected, 

click the Add button. In the New Attribute dialog box, add a 

new attribute named Length_Mi and set its units to Miles and 

the Data Type to Double. Click OK.

What You Will Need

•	ArcGIS Desktop (ArcView, ArcEditor, or ArcInfo license)

•	ArcGIS Network Analyst extension 

•	Sample data downloaded from ArcUser Online 

•	500 MB of free disk space 

http://www.esri.com/news/arcuser/1009/files/Redlands.zip
http://www.esri.com/news/arcuser/1009/files/Redlands.zip
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3. Reselect Minutes. Click the Evaluators button and select the 

Default Values tab. Right-click the Turn and choose Type > 

Global Turn Delay. Click Apply.

4. Press F12 to open the Global Turn Delay Evaluator and type 

in the delay parameters shown in Table 1. Click OK and OK 

again to return to the dialog box for specifying attributes.

Table 1: Delay parameters.

Direction Description Seconds

Straight From Local to Local Road 
across No Roads

0

Straight From Local to Local Road 
across Local Road

1

Reverse From Local to Local Road 30

Right Turn From Local to Local Road 2

Left Turn From Local to Local Road 4

5. Click Next to continue and accept the directions defaults.

6. Click Next, select the summary text, copy and paste it to a 

WordPad document, and save that document with the project.

7. Click Finish and build the network. Inspect it when ArcCatalog 

has finished processing.

Creating Indexes, Generating 
Centroids, and Exporting Data

1. Close ArcCatalog and open ArcMap. Navigate to the  

\Redlands folder and open Redlands01.mxd. Switch from 

Layout View to Data View.

2. Open the attribute table for the Streets with Speed layer. 

Scroll to the right, study the fields, and locate the INDEX, 

CENT_X, and CENT_Y fields.

3. Right-click on INDEX and open the Field Calculator. Double-

click on OBJECT_ID1 to add it to the formula box. Click OK to 

populate this field with a sequential index.

4. Right-click on the header for CENT_X and select Calculate 

Geometry. Choose X Coordinate of Centroid to perform this 

calculation. Use the data frame coordinate system (NAD 1983 

StatePlane California V FIPS 0405) and Feet US as the units for 

this project. Click OK.

5. Repeat this procedure for CENT_Y to calculate values for the  

Y Coordinate of Centroid field. Inspect the calculations and 

save the project.

Specify another attribute for the 
network dataset called Length_Mi. 
With Minutes selected, 
click the Add button and 
set its units to Miles and 
the Data Type to Double.
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6. Now, export this table to a dBASE file so these points can 

be used to map street centroid points. In the Attributes of 

Streets with Speed table, click the Options button and select 

Export. Specify All Records and save the table in the  

\Redlands\DBFFiles folder as Network_Street_Centroids_

XY.dbf. Click on the Source tab of the table of contents (TOC) 

and add the table to the map.

Mapping Incidents

The ArcGIS Network Analyst extension Closest Facility solver 

requires two input datasets: Locations and Facilities. To build 

run orders, load Fire Stations as Facilities and the street segment 

centroids as Incidents. Determining the five closest facilities to 

each centroid Incident will involve considering seven possible 

Facilities and almost 6,500 Incidents, so this model might take 

some time to run. On the Source tab of the TOC, right-click on 

Network_Street_ Centroids_XY.dbf and select Display XY Data. 

In the Display X,Y dialog box, set the X Field to CENT_X and the 

Y Field to CENT_Y. Click OK. After processing is complete, open 

the Network_Street_Centroids_XY.dbf and inspect the location 

of these centroid points. Save the project.

Loading Facilities and Incidents

With the XY event theme created, it is time to add the network 

dataset, load Facilities and Incidents, and define the Closest 

Facility rules.

1. If necessary, make the Network Analyst extension active, load 

its toolbar, and open a Network Analyst window.

2. Click the Add Data button and navigate to the Run_Order_

Model_ND, located in the Run_Order_Model feature dataset, 

and add it. Don't add all the feature classes that participate.

Use the Network_Street_Centroids_XY.dbf to create an XY 
Event layer that will be the input for Incident Data needed when 
calculating Closest Facility.
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3. In the TOC, place Run_Order_Model_ND just below Streets 

with Speed layer and make it not visible.

4. Click the Network Analyst drop-down and select New Closest 

Facility. The Closest Facility group is added at the top of the 

TOC and the Network Analyst window. In the TOC, move the 

Closest Facility to a location just above the Redlands City 

Limits layer at the bottom of the TOC.

5. In the Network Analyst window, right-click on Facilities and 

select Load Locations. Specify Fire Stations and Load From 

source. Carefully apply the loading parameters listed in  

Table 2 and click OK. Save the project.

Table 2: Facilities loading parameters.

Parameter Value

Load From: FireStations

Sort Field: INDEX

Location Position: Use Geometry

Name (under Location Analysis 
Properties):

LABEL

Search Tolerance: 500 Feet

6. Right-click on Incidents and choose Load Locations. Carefully 

apply the loading parameters listed in Table 3 and click OK. 

This may take considerable time, so be patient. If the process 

hangs, close ArcMap, reopen the last saved project, and load 

it again. Inspect the loaded incident data. If it is correct, save 

the project again. 

     Table 3: Incident loading parameters.

Parameter Value

Load From: Network_Street_Centroid_XYEvents

Sort Field: INDEX

Location Position: Use Geometry

Name (under Location Analysis 
Properties)

INDEX

Search Tolerance: 500 Feet

Carefully fill out the dialog box when loading Fire Stations 
for Closest Facility analysis.
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Defining the Closest Facility Solver Parameters

1. In the TOC, right-click on Closest Facility layer and choose 

Properties.

2. In the General tab, rename it to Run Order Closest Facility. In 

the Analysis tab, set Impedance to Minutes, Default Cutoff 

Value to 20, and Facilities to Find to 5. Change Travel from to 

Facility to Incident. Accept defaults for all other parameters.

3. In the Accumulation tab, check the Length_ Mi and Minutes 

attributes. Click Apply to save these parameters. Click OK. 

Save the project. In the TOC, right-click on Closest Facility 

and choose Solve. Now it's time to take a break. There are 

literally thousands of routes in this solution so this process 

may take more than 20 minutes. Close Warning Message that 

Carefully fill out the dialog box when loading the 
Network_Street_Centroids_XY.dbf for Closest  
Facility analysis. Carefully set the Closest Facility Solver parameters.
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lists the centroid points not reached in 20 minutes. Once the 

process has finished, save the project.

4. Open the Routes table. If it contains approximately 32,000 

routes and everything else looks OK, save the project again. 

The ArcMap document has just increased in size from about  

2 MB to more than 100 MB.
Joining Station Information to Each Route

Carefully study each field of the Routes attributes. This data will 

be used to build run orders for each street segment. Notice 

that the FacilityID field corresponds to the Index field in the Fire 

Be patient while several thousand centroids load.

Join the filtered dBASE files to the Streets with 
Speed layer to calculate values, then remove the 
join.
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Stations table. The IncidentID field connects to the Streets Index. 

The FacilityRank lists arrival order, and Total_Minutes contains 

the travel time for each station to each centroid. Open the Fire 

Stations table and place it above the Routes attributes.

1. Before exporting arrival data for First through Fifth Due, join 

station names, apparatus, and personnel to each route.

2. To join Fire Station data to the Routes, right-click on Routes in 

the TOC and select Join. 

3. In the Join Data dialog box, choose Facility ID as the field in 

this layer that the join will be based on, choose Fire Stations 

as the table to join to the layer or load the table from, and 

choose INDEX as the field in the table to base the join on and 

choose Keep all records.

4. Click OK, allow indexing, and inspect the Routes table.

With the Station Number (STATION_N) for up to five responders 

for each modeled street segment, the next step is the crux of this 

entire procedure. 

Exports and Joins

Now to export the five tables, one for each arrival order, 

individually join each table to the streets, and calculate station 

and travel time for each arrival. After successfully joining Routes 

to Fire Stations, the next step is to apply a definition query to 

filter the Routes attributes by arrival and export each subset to a 

separate dBASE table.

1. In the TOC, right-click on Routes and choose Properties. 

Click the Definition Query tab. In the formula box, request 

all records where CFRoutes.FacilityRank = 1. This subset 

represents travel records for first-on-scene stations. Times 

should be short, especially near fire stations.

In the TOC, right-click on Routes, Choose Properties, and select Definition 
Query.
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2. The next step is to export the First Due records. In the filtered 

Routes attribute table, click Options and select Export. Save 

the exported table to Redlands\DBFFiles and name it RO_01 

.dbf. Do not add the table to the map yet.

3. Reset the definition query to CFRoutes.FacilityRank = 2 and 

export again, saving as RO_02.dbf. Again, don't add the table 

to the map.

4. Repeat this procedure for RO_03, RO_04, and RO_05. Now, 

add all five RO files to your map. Save the project again.

Populating Station and Time Fields 
with Joined Table Data

The final analytical steps include five separate joins, each followed 

by two quick calculations. Perform each operation carefully and 

check the data!

1. Open and inspect the attribute table for Streets with Speeds. 

Locate the STAT_01 and TIME_01 fields. Open and position 

RO_01.dbf below the streets attributes.

2. Right-click on Streets with Speed layer in the TOC and select 

Joins and Relates. Verify that there are no active joins for this 

table. (If there are any joins, remove them.) Next create a Join 

with RO_01, using INDEX as the Streets with Speed join field, 

RO_01 as the table to join, and IncidentID as its join field. 

Click OK to continue. Do not index this table. Open the table 

and verify the join.

3. In the joined table, navigate to STAT_01 ad right-click its 

header. Select Field Calculator and populate the RO_01 

.STATION_ NO field with values from Network_Streets. 

STAT_01.

4. Next, use the Field Calculator to populate the TIME_01 field 

with the values from the RO_01.Total_Minu field. Check the 

In the formula box, request all records where 
CFRoutes.FacilityRank = 1.
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work. Null records represent streets that were not traversed 

within 20 minutes.

5. Now for a really important step. In the TOC, right-click 

Streets with Speed, select Joins and Relates, and remove 

the RO_01 join. Do not skip this step.

6. Create new joins on Streets with Speed to the other RO tables 

using INDEX as the field the join is based on, the RO table 

(e.g., RO_02, RO_03), and IncidentID as the field in the table 

to base the join on. Populate the station (STAT_0x) using the 

formula Header = STAT_0x, the field to populate = Network_

Streets.STAT_0x, and the value to use is RO_0x.STATION_NO. 

Populate the arrival time fields using the formula: Header = 

TIME_0x, the field to populate = Network_Streets.TIME_0x, 

and the value to use is RO_0x.Total_Minu. Be sure to remove 

the join each time.

Calculating Delay Time

Now, calculate the delay time between arrival of the first and 

second responders. A fire engine typically includes three or 

four firefighters. To safely conduct rescue and initial interior 

operations, more firefighters are often needed. Subtracting the 

First Due arrival time from the Second Due time will produce the 

approximate time interval between when the first on-scene crew 

arrives and a second crew arrives. Right-click on TIME_02_01 and 

choose Field Calculator. Enter the formula [TIME_02] – [TIME_01] 

Use the Field Calculator to calculate the delay time between First Due 
and Second Due.
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in the formula window and click OK. Inspect this calculation and 

save again.

Mapping Run Orders—The Bonus Round

Now it is time to make some maps. The Redlands folder in the 

sample dataset contains a Bonus folder with several Layer files 

for symbolizing the various responders (First Due, Second Due, 

etc.). Load all these Layer files and create a Group Layer for 

them named Run Order Group. Place the group just below Fire 

Stations in the TOC. Collapse the legends for Second, Third, 

Fourth, and Fifth Due.

Notice that data links to all Run Order layers are missing. To fix 

this, right-click on First Due in the TOC and choose Data > Repair 

Data Source. Navigate to \GDBFiles\CASP835F\Redlands_Fire 

.gdb and select Network_Streets inside the Run_Order_Streets 

feature dataset. Fix all layers in the Run Order Group in a similar 

manner. Turn off all Run Order layers except First Due. Switch to 

Layout View and study the colors. These First Due polylines seem 

to cluster around their home stations.

Verifying Relationships

To verify First Due relationships, click Add Data and navigate to  

\Bonus_Files\SHPFiles\ CASP835F and load Optimized Travel 

Area.lyr. Place it at the top of the Run Order Group. This response 

area optimization was built from the same Redlands Streets using 

the functionality in Network Analyst to optimize service areas. 

Notice the alignment of First Due Streets and optimized response 

area boundaries, providing visual confirmation of the First Due 

run orders.

Turn off First Due and turn on Second Due. Look closely at the 

home area for Redlands Station 261 and observe how Station 264 

arrives second from the west, 263 comes in from the north, 262 

fills in from the south, and Mentone 9 just reaches the eastern 

response area for Station 261 as Second Due. Check the Third, 

Fourth, and Fifth Due layers. 

Finally, let's map the arrival time difference between First and 

Second Due. Turn off all Due layers and make the Second Due 

minus First Due layer visible. Study the color relationships. Green 

lines represent short time intervals and red lines represent long 

intervals. Notice the large time differences for each station are in 

closest proximity to that station.

Study the attributes to understand that the green lines in fringe 

areas are not entirely good. Even though the arrival difference is 

small, the First Due times often exceed five minutes. Look inside 

the City of Redlands. The time difference throughout much of the 

populated city is small, except in the most southern areas near 

Station 262 where all supporting responders must come from the 

north.

As a bonus exercise, create thematic legends for all layers in the 

Run Order Group and design a separate map for each. Load 

http://www.esri.com/news/arcuser/1009/files/Redlands_Bonus.zip
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these maps into Microsoft PowerPoint to create an informative 

slide show.

Run Order Benefits and Limitations

Run orders provide emergency responders with an accurate, 

reliable way to model complex responses with travel from 

multiple locations. This workflow counts on response from fixed 

facilities with all responders who are dispatched simultaneously. 

This method works well for a static, districtwide model that 

includes automatic and mutual aid. As mobile dispatching and 

automated vehicle locators (AVL) become widely deployed, this 

workflow will need to be simplified to speed up individual event 

dispatching.

In more complex scenarios, appropriate lag times are applied to 

manually requested resources and volunteer responders to reflect 

additional time necessary for their departures. Also, unavailable 

units may be removed from the response stack. Apparatus types 

and personnel counts may also be included. As a word of caution 

in rural areas: when modeling long stretches of country roads, be 

sure to break street segments into appropriately short intervals.
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It's All About Streets
Tips and tricks for obtaining, building, and maintaining time-based network streets

By Mike Price, Entrada/San Juan, Inc.

Editor's note: Mike Price has been a regular 

contributor of articles on creating models with GIS 

since this magazine's inaugural year. Over the last 

two years, he has authored a series on modeling 

street network data for public safety applications 

using the ArcGIS Network Analyst extension. In this 

article, he shares the data requirements for this type 

of modeling and tips he has discovered over the 

years for enhancing and managing those datasets.

It's often said, “Time is of the essence.” This is certainly true 

when it comes to modeling networks for public safety response.

I now believe that finding/creating and supporting an accurate, 

reliable street network is the single most important part of 

building and using any public safety model. Unfortunately, 

locating or creating a network-ready street set that is current, is 

complete, and contains the necessary attribution is not easy.

Here are some tips and tricks that I use to find, enhance, and 

maintain a quality network street dataset. If you are new to 

modeling networks with ArcGIS Network Analyst or would like 

a refresher course on time-based response modeling, visit the 

Learn How to Model Networks page.

When I model networks, I may use one of four different street 

data sources: simple Census TIGER streets, StreetMap in the 

Esri Data & Maps DVD set that comes with ArcGIS, commercial 

network products, and customized datasets that are often built 

by a local jurisdiction or its GIS partner. Here is a brief summary 

of these data types.

Census TIGER Streets

TIGER streets, part of Census 2000 TIGER/Line Data, is a free 

source for streets. County TIGER streets may be downloaded 

from Esri's Free Data Web page (www.esri.com/freedata). The 

Census 2000 TIGER streets are outdated, and I'm waiting for the 

Census 2010 update. TIGER spatial geometries are approximate 

and they do not directly contain time impedance. The Census 

Feature Class Code (CFCC) may be joined to the streets to obtain 

typical speeds. For an early tutorial on using Census TIGER 

streets, see “Taming TIGER Data.”

Esri Streets

For years, Esri has provided StreetMap in Esri Data & Maps, which 

ships with ArcGIS. To see these streets, locate the StreetMap 

http://www.esri.com/news/arcuser/avmodel.html
http://www.esri.com/data/free-data/index.html
http://www.esri.com/news/arcuser/0103/files/tiger.pdf
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DVD on a current Esri Data & Maps DVD set. These streets do 

include speed limits but compare this information with local 

signage. You may want to clip your favorite areas and save them 

as shapefiles or file geodatabases. Esri also sells StreetMap 

Premium (esri.com/data/streetmap), which provides streets that 

readily support geocoding and routing. Point-to-point routing is 

also available through the ArcGIS Online routing service.

Commercial Streets

Tele Atlas/TomTom and NAVTEQ are the two major commercial 

network street providers in North America. Commercial streets 

are available by subscription and include periodic updates. 

Vendors of street data also encourage users to provide current 

content.

Tele Atlas/TomTom provides digital maps and dynamic content 

that power essential navigation and location-based services. 

The company provides several products, including its MultiNet 

geocoding and routing dataset. MultiNet streets incorporate 

a full suite of capabilities, allowing users to locate the people 

and services they need quickly; reach their destinations via safe, 

reliable, and customizable routes; and use the clearest, most 

visually compelling maps available. Check out the MultiNet 

streets at www.teleatlas.com/OurProducts/MapData/Multinet 

/index.htm.

NAVTEQ provides high-quality street data to partner developers 

that incorporate it into many applications. Visit NAVTEQ Map 

online at www.navteq.com or contact NAVTEQ and find a partner 

vendor that can provide data for local needs.

Custom Street Datasets

Local agencies often create their own street centerline and 

travel lane data using a variety of sources including orthophoto 

digitizing, GPS data collection, and engineering drawings. These 

datasets are typically customized to meet local needs. They may 

be good for either geocoding or networking, but not both. Since 

they are supported locally, work with these providers to extend 

the capabilities of these datasets. To see several local datasets, 

check out the article, “Do It Yourself—Building a network dataset 

from local agency data” and “Managing Volunteer Firefighter 

Response—Using the OD cost matrix to model personnel 

availability.”

Enhancing Street Data for Networks

Here comes the really important stuff! When you are sourcing (or 

have already obtained) a street dataset, what important network 

issues should you address? In a recent ArcUser article, “Do It 

Yourself—Building a network dataset from local agency data” 

(referenced above), I introduced several important issues you 

should consider when preparing a dataset for network modeling. 

http://www.esri.com/data/streetmap/index.html
http://www.tomtom.com/en_gb/licensing/?IdcService=SS_GET_PAGE&siteId=TeleAtlasCW1&siteRelativeUrl=%252FOurProducts%252FMapData%252FMultinet%252Findex.htm&ssUrlPrefix=/
http://www.tomtom.com/en_gb/licensing/?IdcService=SS_GET_PAGE&siteId=TeleAtlasCW1&siteRelativeUrl=%252FOurProducts%252FMapData%252FMultinet%252Findex.htm&ssUrlPrefix=/
http://www.navteq.com/
http://www.esri.com/news/arcuser/0609/files/doityourself.pdf
http://www.esri.com/news/arcuser/0609/files/doityourself.pdf
http://www.esri.com/news/arcuser/0507/files/odmatrix.pdf
http://www.esri.com/news/arcuser/0507/files/odmatrix.pdf
http://www.esri.com/news/arcuser/0507/files/odmatrix.pdf
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Here are key issues that can be tackled by spatial and attribute 

editing.

Impedance—Distance

To properly calculate travel time, you need accurate distances. 

In a well-defined and documented model, distance-based 

impedance is easy to calculate. If your streets are registered 

in a standard projected coordinate system, you can readily 

calculate and verify distances between intersections in the 

native coordinates. If you are careful, you can calculate distance 

in a geographic data frame or across the metric/imperial 

measurement divide.

I use a field named Length_Mi to store travel distance. Since 

this is not a reserved field name, you must specify this field and 

its units when you build a network. I do not use the field name 

Length, as I often store length in multiple units of measurements 

(both metric and imperial) and certainly do not want to confuse 

these systems. As you edit your network dataset, recalculate 

segment lengths frequently, especially before you rebuild a 

network.

Impedance—Speed

A reliable time-based impedance (or speed) field is essential. 

Many agencies start with posted or ordinance speeds and 

factor them up or down, depending on policy, persistent 

travel constraints (such as slope and turn radius), and variable 

travel factors (weather, traffic, and disruptions, to name a few). 

Measured travel times allow a user to fine-tune speed-based 

impedance. Once directionality and connectivity issues are 

resolved, the segment length in miles and travel time in minutes 

can be calculated. If you use a field named Minutes, Network 

Analyst will recognize it immediately. Remember to recalculate 

segment length, then travel times on all street segments (or at 

least the ones edited) each time you finalize an edit session and 

before you rebuild your network. Be sure to edit or remove all 

zero-time segments in the dataset before you rebuild.

Crossing Relationships

Overpasses and intentionally nonconnecting crossings are two of 

the most difficult and important issues to address. Commercial 

streets use an integer code or Z elevation/Z level to manage 

crossing geometries. The Z elevation fields (from and to) specify 

whether traffic may turn at an endpoint intersection. To turn or 

traverse through an intersection, the endpoint of the traveled 

segment must match the start point of the new segment. Most 

simple networks will use only Z values of 0 and 1. However, a 

Los Angeles County commercial dataset that I recently modeled 

included Z elevation values up to 4. If you add new streets to a 

dataset that uses Z elevations, be sure to correctly populate this 

field.
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A simpler way to manage crossing relationships, especially streets 

not also used for geocoding, is to build nonintersecting crossing 

geometries and apply endpoint connectivity. These streets are 

much easier to edit and visually inspect, and they perform much 

better if you are using lidar terrain to define slope impedance.

Connectivity

Connectivity defines how an individual element in a network 

relates to its neighbors. Simple connectivity options include 

endpoint and any vertex. I strongly recommend that you use 

endpoint connections. See Crossing Relationships, in the 

previous section, for more information.

Simple single-layer networks must have exact endpoint 

connections to function properly. I find that nonconnecting 

segments are the most common issue that will cause a network 

to fail. Use visual inspection, polyline topology, editing, and/

or old-fashioned trial and error to define, repair, and maintain 

connectivity.

If you use a multimodal network that includes several feature 

classes, connectivity between participants is defined with special 

rules. Remember that you must place all participating feature 

classes in a single feature dataset to build multimodal models.

Directionality

Travel direction is critical when modeling one-way travel on 

divided highways, boulevards, one-way streets, and even 

individual travel lanes.

When streets are digitized, the digitizing direction creates an 

underlying street direction. To manage travel along or against this 

direction, a two-character text field named One_Way provides 

an effective way to flag travel direction relative to digitizing. 

Simple FT (from-to) and TF (to-from) codes define the course 

along and against the digitized direction. To check directionality 

against digitized direction, place small arrows at the terminating 

end of the street segment. Code a selected segment FT if travel 

is along the elements direction; use TF if travel opposes. In an 

edit session, also watch for the segment's red endpoint; it also 

represents the terminating end.

If your street network will not support address geocoding, you 

may also flip the street direction to reflect actual travel. Again, 

check out “Do It Yourself—Building a network dataset from 

local agency data” to learn this workflow. If you do use streets 

for geocoding, you may still reverse its direction, but you 

must reassign the left/right to/from values to respect the new 

orientation. This difficult task requires attention to detail, and I do 

not recommend it for beginners.

When you build a network dataset, Network Analyst will 

recognize the One_Way field and create the appropriate rules. 
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When using the network, you will have the option to globally turn 

the One Way property on or off.

Turns and Turn Relationships

In a time-based network, turns and intersection slowdowns are 

very important. Global turns may be quickly applied throughout 

a network. As you build your network, use actual field times to 

calibrate them throughout your jurisdiction. You will probably 

find that travel times under constant low volume will vary slightly 

throughout your area. Experiment with global turns to achieve 

a best average. Field testing is described in “Convincing the 

Chief—Proving that time-based networks really work,” an article 

that appeared in the Spring 2009 issue of ArcUser and that is 

also available from the Network Modeling, Learn How to Model 

Networks Web page. These Hands On articles build skills.

If you want to model individual turn penalties for many or all 

intersections, you can create individual rules for all intersections. 

This is a complex procedure that I do not recommend for people 

who are new to working with networks.

•	 Don't Give Up 

Stay with it. As you refine your network, you will be amazed 

with the possibilities. Building a reliable time-based network 

is not an easy task, and tuning and maintaining it are even 

tougher. Do not be discouraged. There are probably many 

potential partners in and around your jurisdiction that might 

want to help. In addition to finding some help in creating and 

maintaining your network data, here are some strategies for 

making the job easier. 

•	 Start Small 

Build a small network in an area that you know well. 

Experiment and tune it to match field tests. Carefully watch 

how the network behaves as you build small service areas and 

test routes. If impedance, connectivity, geometry, and travel 

direction misbehave, practice fixing and rebuilding them. Test, 

and test, and test! 

•	 Think Big 

Ultimately, your network will probably support the response 

efforts of many jurisdictions. Talk to your neighboring 

jurisdictions and develop partnerships. Collectively decide to 

obtain/create and maintain just one network dataset. 

•	 Keep Both Eyes Wide Open 

Continually monitor your network's behavior. Repair problems 

individually or in small groups. Rebuild and retest problem 

areas. Do not be discouraged if fixing one problem just 

reveals another. 

•	 Document Your Work 

Develop a method to track edits and network builds, 

especially when adding new segments and modifying 

attributes. When you build the network for the first time, 

before you click the Finish button, save your parameter 

http://www.esri.com/news/arcuser/avmodel.html
http://www.esri.com/news/arcuser/avmodel.html
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summary to a text file with a date stamp. If you ever have to 

present and defend your work, you will be glad you did. I 

have presented network models to the legal community, and 

this information is priceless. 

•	 Back Up and Try Again 

Occasionally, a network dataset becomes quirky or even 

corrupt. Do not hesitate to delete the problem set and rebuild 

using the same parameters. If you use a standard naming 

convention, you might be able to reuse the same dataset 

in an existing ArcMap document. Be very careful with this, 

though. You might have to remove the repaired dataset from 

an existing ArcMap document and rebuild all the solvers. I 

have had mixed success with replaced datasets and consider 

the jury to still be out on this strategy.

(This article originally appeared in the Fall 2009 issue of ArcUser.)

http://www.esri.com/news/arcuser/1009/files/networkstreets.pdf
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The Call Comes In
Quickly and accurately map emergency incidents with a composite address locator

By Mike Price, Entrada/San Juan, Inc.

Address geocoding is an essential public safety skill. However, 

officers need to understand the benefits, limitations, and 

complexities of systematic address locators. To quickly and 

accurately map incident locations, a Public Safety Access Point 

(PSAP) relies on computer-aided dispatch (CAD) software and 

georeferencing datasets to match the caller's address to a point 

on the map. At the dispatch center, a trained operator must 

capture, interpret, record, and map as much incident information 

as possible.

After determining the incident's location, the operator identifies 

the needed and available resources and passes as much 

information as possible to responding units. These tasks must be 

accomplished as quickly as possible—typically 60 seconds or less. 

Once mapped, the CAD system matches the closest available 

emergency resources with the call type and sends out automated 

tones, coupled with digital information and voice instructions. 

Consistent, complete, and current addressing datasets are 

essential to this process.

This exercise shows how to produce addressing datasets by 

creating geocoding services or address locators for three 

datasets that will place a location on a map with a high degree 

of accuracy. Rather than geocoding a single incident, this 

exercise processes several thousand incident points captured 

during a single year in a major metropolitan area. Standardizing 

addresses and using a progressive composite address locator 

will achieve an extremely high success rate on the very first pass. 

This exercise applies the same sequential logic that is used by 

response centers around the world.

The data for this exercise was created for a textbook and tutorial 

series on performing emergency services mapping. It is based on 

data from actual jurisdictions and represents field conditions but 

has been modified to protect sensitive information.

The exercise is organized into five tasks:

Task 1: Understanding Addressing Data 

Obtain and analyze geocoding reference data. Review incident 

data format(s). 

Task 2: Creating Individual Address Locators 

Design and build stand-alone address locators for each reference 

dataset. 
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Task 3: Building a Composite Address Locator 

Combine all address locators in hierarchical order in a composite 

address locator. 

Task 4: Geocoding Incidents 

In ArcMap, geocode nearly 7,000 emergency incidents, updating 

unmatched addresses and resolving ties. 

Task 5: Adding Detailed Information about Incidents 

Join incident date and type information to all geocoded points 

to display fires and explosions, Hazmat incidents, emergency 

medical services (EMS) responses, and service calls.

Getting Started

To get started, download Lakewood.zip [ZIP]. Store this file 

near a root directory and extract the data, respecting directory 

structure. Start ArcMap, navigate to the new Lakewood folder, 

and open Lakewood1. Right-click in an open toolbar area and 

select the Geocoding toolbar. Move it next to the other open 

toolbars and inspect its buttons. The Address Locator Manager 

and Geocode Addresses buttons are active. Two other tools, 

Location Inspector and Review/Rematch Addresses, are inactive.

Task 1: Understanding Addressing Data

A typical PSAP will use several address datasets to place an 

incident on a map. A geocoding sequence starts with the most 

reliable, accurate, and current dataset available to identify a 

single point location on a map. To increase the success rate of 

the geocoding process, the service will standardize incoming 

What You Will Need

•	ArcGIS Desktop 9.3 (ArcView, ArcEditor, or ArcInfo) 

•	Sample dataset [ZIP] downloaded
The exercise data is based on data from actual jurisdictions and represents 
field conditions but has been modified to protect sensitive information.

http://www.esri.com/news/arcuser/0410/files/lakewood.zip
http://www.esri.com/news/arcuser/0410/files/lakewood.zip
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addresses to match the reference data schema. Place-name alias 

tables also increase geocoding reliability.

1. Open the attribute table for GC1 Parcel Centroids and inspect 

its fields. Study the SITE_FULL field and sort it. Notice that 

each address includes one standardized string, possibly 

including an address numeric; a direction prefix, a street 

name, a street type, and a direction suffix. These address 

points provide a certain address match against standardized 

input data with a high degree of reliability. 

2. Open the attribute table for GC2 City Streets and inspect 

its fields. This dataset, developed and maintained by the 

Lakewood Public Works Department, is current and complete. 

This polyline dataset separates addressing into left and right 

and to and from numerics, and includes separate fields for 

name direction and type. GC2 City Streets is the second 

geocoding data source. It supports a U.S. Streets Locator. 

Unfortunately, CAD data often does not include sufficient 

information to apply a U.S. Streets with Zone Locator. Typically 

this data lacks municipality or ZIP Code information. Each 

agency must decide how to clip streets to include unique 

names or process addresses in different communities that 

share similar street names. 

3. Next, open the attribute table for the GC3 TIGER Street 

shapefile and inspect its fields. This dataset is adapted from 

2009 Census TIGER street data, now in development by 

the U.S. Census Bureau. It includes a schema similar to the 

Lakewood Public Works data. Notice that field names and 

placement are different. This is the third addressing dataset, 

and it captures many road intersection addresses and the 

locations of incidents that might occur outside the extent 

of the Public Works dataset. The TIGER 2010 data, not yet 

released, will be different from TIGER 2000 data. 

4. Now click the Add Data button, navigate to \Lakewood 

\DBFFiles and locate Inc_2008_Address, and load this table 

containing incident data. Open this table and inspect it. This 

dataset contains nearly 7,000 incident records and has only a 

few fields. It has an index field (INDEX), an incident number 

field stored as an alpha string (INC_NO), and a standardized 

address field named ADDRESS2. Notice that there is no field 

in this dataset to identify a geocoding zone. 

5. Sort ADDRESS2 and notice it contains both numeric and 

street intersection addresses. These addresses were 

generated and posted using CAD software, then edited by 

the local jurisdiction to correct inconsistencies. This data is 

clean and contains only incident addresses. Other information 

will be joined to these geocoded points later using the INC_

NO field. 

To review: In this task, the three reference datasets in the map 

document were reviewed, and one file containing incident data 

was added to the map document.



Fire Mapping: Building and Maintaining Street Networks in ArcGIS June 2012 79The Call Comes In

Task 2: Creating Individual Address Locators

Address locators will be created for each reference dataset in this 

task.

1. Save the ArcMap document, close ArcMap, and start 

ArcCatalog. Navigate to \Lakewood\SHPFiles\StatePlane and 

preview the tables and geography for the shapefiles. The file 

name for each reference file begins with the letters GC and a 

numeric code that indicates that file's geocoding sequence. 

2. In the ArcCatalog tree, right-click the \Lakewood\SHPFiles 

\StatePlane folder and select New > Address Locator. Specify 

Single Field as the Address Locator Style and click OK. 

3. In the New Single Field Address Locator dialog box, enter  

1_Parcel_Single_Field as the Address Locator name. On the 

Primary table tab, set Reference data to \GC1_Parcel.shp and 

set SITE_FULL as the Key Field. In the Input Address Fields 

area, delete Name from the field under is recognized if it is 

named and add Address2. Set all scores and sensitivities to 

100. 

4. Under Output options, uncheck the box next to Match if 

candidates tie. It is essential to uncheck this box because all 

ties (based on duplicate addresses) will be bumped to the 

City Streets locator. Click OK to build the 1_Parcel_Single 

_Field locator. 

Create a Single Field Address Locator that references the GC1_Parcel 
shapefile.
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5. Build the 2_City_US_Streets geocoding service by right-

clicking the \Lakewood\SHPFiles\StatePlane folder and 

creating a second address locator. Use Tables 1 and 2 as 

guides when creating this locator. Name this address locator 

2_City_US_Streets. Set \GC2_City_Street.shp as the reference 

set, and define reference fields using the same parameters as 

1_Parcel_Single_Field locator. This time, using the information 

in Table 1 [PDF] , specify fields for numerics, direction, and 

type. Although many addresses will automatically match, 

don't forget to make sure STYPE is chosen for the Street Type 

field. If a required field is accidentally omitted when creating a 

locator, delete the locator and rebuild it. Set only Address2 as  

The second geocoding data source, GC2 City Streets, supports a 
U.S. Streets Locator. It is maintained by the Lakewood Public Works 
Department and is current and complete. It will be used to build the  
2_City_US_Streets address locator.

The data source for the third address locator, the GC3 TIGER Street 
shapefile, was adapted from 2009 Census TIGER street data, now in 
development by the U.S. Census Bureau.

http://www.esri.com/news/arcuser/0410/mp_geocoding_tables.pdf
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the recognized field and set spelling and scores to 80, 60, and 

80. Accept the Connectors defaults and leave other choices 

unchanged. Click OK to build this locator. 

6. Next, build the 3_TIGER_US_Street geocoding service using 

parameters in Tables 1 and 2. This locator is similar to the 

2_City_US_Streets locator. Because the new TIGER codes are 

not consistent with earlier systems, the field names will not 

assign automatically, so carefully assign fields as shown in 

Table 2 [PDF]. 

Task 3: Building a Composite Address Locator

The three individual address locators just created are now linked 

together in a composite address locator. A composite locator 

links two or more other address locators together in a hierarchical 

order and passes unmatched addresses from each locator to the 

next. This composite address locator will geocode using Parcel 

Centroids first, then City Streets, and finally TIGER Streets.

1. Right-click the \Lakewood\SHPFiles\StatePlane folder and 

specify Composite Address Locator. 

2. Using Table 3 [PDF] , name this locator Composite_Parcel_ 

Street_TIGER and add participating locators in order: 1_, 2_, 

and 3_. These numeric name prefixes will be useful soon.

3. Once all three are loaded, perform the next step. It is a 

performance tip. On the right side of the New Composite 

Address Locator wizard, find the Input Address Fields area. 

Next to The field containing window, click the Add button and 

specify Address as the primary field. Set its recognized name 

to only Address2. By specifying only Address2, the composite 

address locator will target only standardized data and ignore 

Use the three individual address locators to create a composite address 
locator.

http://www.esri.com/news/arcuser/0410/mp_geocoding_tables.pdf
http://www.esri.com/news/arcuser/0410/mp_geocoding_tables.pdf
http://www.esri.com/news/arcuser/0410/mp_geocoding_tables.pdf
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other Address fields. Typically reference datasets can also 

contain a primitive Address field.

4. Keep all Participating Address Locators checked; select each 

one and individually set its Input Mappings field to Address. 

Use any individual address locator to calculate the output 

spatial reference. After setting the spatial reference and 

all three Input Mappings, the OK button should become 

active. If it does not, review the setting. Click OK to build the 

composite address locator. Now it is time to geocode all 6,976 

incidents. Close ArcCatalog and reopen the Lakewood map 

document in ArcMap. 

Task 4: Geocoding Incidents

Now, after setting some parameters for the composite address 

locator, it will automatically geocode all the incidents.

1. In ArcMap, load the Geocoding toolbar, if necessary, and click 

the Address Locator Manager button. Navigate to  

\Lakewood\SHPFiles\StatePlane and load only Composite 

_Parcel_Street_ TIGER. Close the Locator Manager window. 

2. Open the TOC Source tab, right-click the Inc_2008_Address 

table, and select Geocode Addresses.

3. Set the output file location and name to \Lakewood\SHPFiles 

\StatePlane\Inc_2008_GC1. Using a numeric counter in the 

file name will make it easier to rerun the model or test it with 

differing parameters. Click the Geocoding Options button 

to verify that all three individual locators participate in the 

composite address locator. Update or adjust properties, such 

as spelling sensitivities and threshold scores, at the same time 

if necessary. Click OK to continue and watch the geocoding 

process.
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4. If the three address locators were built according to the 

specifications given, they should generate a high percentage 

of matches. Only about 20 ties and 12 unmatched addresses 

should be left from the set of 6,976 incidents. 

5. The sample dataset includes a Microsoft Excel spreadsheet 

containing suggested fixes for known addressing errors. 

Navigate to \Lakewood\Utility and load the Database 

worksheet, Fixes1.xls. Review its contents. In the real world, 

records management at a fire station is never perfect, and this 

spreadsheet contains fixes for several nongeocoded records.

Keep all Participating Address Locators checked and 
select each one and individually set its Input Mappings 
field to ADDRESS2.

The composite address locator should generate 20 ties and 12 unmatched 
addresses.
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6. To update these unmatched or tied records, click the Rematch 

button. Let's repair unmatched addresses. Under Interactive 

Rematch, look at the Show results area and select Unmatched 

Addresses. In the results window, locate an improperly 

geocoded address and find its corresponding entry in the 

Fixes1 table. Copy the ADDRESS2_F string into the text box 

next to Address on the left side of the Interactive Rematch 

dialog box. Click the address in the Candidates list and select 

the record with the highest percentage (which will likely be 

the one with the highest order, e.g., 1_, 2_, or 3_) and click 

Match. The score will change from U to M, and the Loc_name 

field now lists reference data, providing the best fit. Continue 

down the list, making repairs, selecting the best reference 

data and building matches. When finished, all records should 

match. 

7. Review tied records next. In Show results, select Matched 

Addresses with Candidates Tied. Locate the ADDRESS2 

window and sort its contents so identical tied addresses are 

grouped. Ties often occur in clusters, so fixing one will often 

fix others. 

8. Click one of the candidates in the window. The selected 

record is displayed as a larger yellow dot on the map. Below 

the Candidates window, click the Zoom to Candidates button. Click the Rematch button and under Interactive Rematch, select 
Unmatched Addresses.

Use the Fixes1 table to fix unmatched addresses by copying the 
ADDRESS2_F string into the text box next to Address on the left side of 
the Interactive Rematch dialog box.
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If you could access the actual incident records, you could 

select the appropriate point. However, that is not the case in 

this exercise, so select the westernmost or northernmost point 

(as long as these points are in close proximity—say, 1,000 feet 

or less). Click the Pick Address from Map button and use the 

crosshair tool to choose the best candidate, then click Match. 

Also check the Fixes1 spreadsheet to see if any ties show up 

there.

After matching the last tied records, all tied records should show 

a 100 percent score. While matching ties, look for the reasons 

they occurred. Some are readily fixed by editing street address 

ranges, which will require that you rebuild the affected address 

locators before continuing. Other errors, such as those caused by 

looped streets and offset intersections, are hard to avoid.

Finally, consider matched addresses that score less than 100. 

Show results for matched addresses and sort the Score field 

in ascending order. Only a few records will have scores less 

than 100. See if you can boost those scores to 100 by using 

observations, intuition, and the Fixes1 spreadsheet. After fixing 

all records, close the Interactive Rematch dialog box and save the 

map document.

Task 5: Adding Detailed Information about Incidents

The input data contains only incident numbers and addresses. 

With all these points properly placed on a map, joining or relating 

data from other tables will add more information on the incidents 

such as date and type of incident. The last step will symbolize 

incidents using a graduated color scheme that identifies incidents 

by type.

1. Navigate to \Lakewood\DBFFiles and add Inc_2008_Date 

_Type.dbf to the map document. Open Inc_2008_Date_Type 

and compare it to the attribute table for Geocoding Results: 

Inc_2008_GC1. Note that these tables share a common field, 

INC_NO, so there may be a one-to-one relationship between 

the tables.
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2. Right-click Geocoding Results: Inc_2008_GC1 and choose 

Join. Create this join to Inc_2008_Date_Type.dbf using  

INC_NO as the common field. Inspect the results and verify 

that all records have joined.

3. The next step symbolizes incident points using a graduated 

color legend that corresponds to the National Fire Incident 

Reporting System (NFIRS). Open the Layer Properties dialog 

box for the incident layer (Geocoding Results: Inc_2008_GC1) 

and click the Symbology tab. Click the Import button and 

choose ArcView 3 (*.avl) file and navigate to the \Lakewood 

\Utility folder. Select nfirs5_3.avl and set the Value field to 

NFIRS_TYPE. Click OK several times to apply the legend.

Join the table Inc_2008_Date_Type to 
Geocoding Results: Inc_2008_GC1 to 
symbolize the incidents. 

Load the ArcView 3.x legend to use the NFIRS color scheme. 
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4. Save the finished project. Once the color scheme is applied, 

check the symbology properties to learn more about NFIRS 

incident types. Incidents are coded thus: 100 series points are 

fire related; 200 series points are explosions or ruptures;  

300 series points are rescues and EMS calls; 400 series points 

are hazardous conditions; and all points over 499 are service 

calls, false alarms, and special calls.

Once the incidents are symbolized, check the symbology properties to 
learn more about the incidents.
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